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About this Manual 
 

This manual describes the structure, project engineering and the handling 
of the Commander Compact CC 03 from VIPA. 
 

Chapter 1: Hardware description  
In this chapter the hardware components of the CC 03 are described. 
Besides of a description of the single components, the dimensions that are 
required for the installation of the CC 03 may also be found. The chapter 
closes with the technical data. 
Please consider the safety hints at the beginning of the chapter. 
 
Chapter 2: Deployment CC 03 - Operator panel  
This chapter explains the deployment and the project engineering of the 
operator panel of the CC 03. 
After the fast introduction there are information about the installation of the 
CC 03 and the configuration by the OP-Manager. This is followed by notes 
for commissioning. The chapter closes with a description of the operation 
of the panel. 
 
Chapter 3: Deployment CC 03 - CC-CPU  
This chapter includes all information required for the deployment of the CC-
CPU, from the project engineering and addressing up to firmware update 
and commissioning. 
 
Chapter 4: Deployment CC 03DP with PROFIBUS-DP 
Content of this chapter is the deployment of the CC 03DP with PROFIBUS. 
It includes all information required for deploying an intelligent PROFIBUS 
DP slave. 
 
Chapter 5: Functions operator panel 
This chapter informs you about the functionalities of the operator panel. 
Especially referred to is to the functions that are part of the standard 
project. 
The text describes how you access screens, use operating keys, react to 
messages, alter values and use the password protection. 
 
Chapter 6: General installation guidelines 
The chapter gives you information about the interference-free installation of 
Programmable Logic Controls (PLC) together with a CC 03. 
Here we describe possible paths how interference can enter the controller, 
how you ensure the electromagnetic compatibility (EMC) and how to 
approach shielding and screening issues. 

Outline 
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This manual describes the Commander Compact from VIPA. The manual 
consists of chapters. Every chapter provides the description of one specific 
topic. 
It describes the installation, project engineering, usage and the technical 
data. 
 
This manual is relevant for: 
Product Order number ab Stand: 
  HW FW 
CC 03 VIPA 603-xCC21 01 4.0.6 
 VIPA 603-xCC22 02 4.1.2 
 VIPA 603-xCC23 02 4.1.2 
 
This manual provides the following guides:  
• An overall table of contents at the beginning of the manual 
• An overview of the topics for every chapter 
 
The manual is available in: 
• printed form, on paper 
• in electronic form as PDF-file (Adobe Acrobat Reader) 
 
[Button] Buttons are put in brackets e.g. [NEXT] or [OK]. 

[Key] Key entry are put in brackets e.g. [STRG]+[A]. 
Display 
output 

Display outputs are illustrated as Courier e.g.
\flashdisk> 

Keyboard 
entry 

Keyboard entries are illustrated as Courier bold e.g. 
\flashdisk> Dir 

Terms Menus, Display elements, terms are italics. 
 
Important passages in the text are highlighted by following icons and 
headings: 
 

Danger! 
Immediate or likely danger. 
Personal injury is possible. 
 

Attention! 
Damages to property is likely if these warnings are not heeded. 
 

Note! 
Supplementary information and useful tips. 
 

Objective and 
contents 

Guide to the 
document 

Availability 

Description 
conventions 

Icons 
Headings 
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Safety information 
 

The Commander Compact is constructed and manufactured for: 
• VIPA CPUs 11x, 21x, 31x, 51x and S7-300/400 from Siemens 
• communication and process control 
• general control and automation applications 
• industrial applications 
• operation within the environmental conditions specified in the technical 

data 
• installation into a cubicle 
 

Danger! 
This device is not certified for applications in 
• in explosive environments (EX-zone) 
 

The manual must be available to all personnel in the 
• project design department 
• installation department 
• commissioning 
• operation 
 

The following conditions must be met before using or commissioning 
the components described in this manual: 
 
• Modification to the process control system should only be carried out 

when the system has been disconnected from power! 
 
• Installation and modifications only by properly trained personnel 
 
• The national rules and regulations of the respective country must be 

satisfied (installation, safety, EMC ...) 
 

National rules and regulations apply to the disposal of the unit! 
 
 

Applications 
conforming with 
specifications 

 

Documentation 

 

Disposal 
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Chapter 1 Hardware description 
 

In this chapter the hardware components of the CC 03 are described. 
Besides of a description of the single components, the dimensions that are 
required for the installation of the CC 03 may also be found. The chapter 
closes with the technical data. 
Please consider the safety hints at the beginning of the chapter. 
 

 

Topic     Page 
Chapter 1 Hardware description ..................................................... 1-1 

Safety information for Users................................................................. 1-2 
Properties............................................................................................. 1-4 
Structure .............................................................................................. 1-5 
Components......................................................................................... 1-6 
Dimensions ........................................................................................ 1-11 
CC-CPU - Function security ............................................................... 1-12 
Technical data.................................................................................... 1-13 

 

 

Overview 

Content 
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Safety information for Users 
 

VIPA modules make use of highly integrated components in MOS-
technology. These components are extremely sensitive to over-voltages 
that can occur during electrostatic discharges. 
The following symbol is attached to modules that can be destroyed by 
electrostatic discharges: 

 
 
The symbol is located on the module, the module rack or on packing 
material and it indicates the presence of electrostatic sensitive equipment. 
It is possible that electrostatic sensitive equipment is destroyed by energies 
and voltages that are far less than the human threshold of perception. 
These voltages can occur where persons do not discharge themselves 
before handling electrostatic sensitive modules and they can damage 
components thereby, causing the module to become inoperable or 
unusable.  
Modules that have been damaged by electrostatic discharges may fail after 
a temperature change, mechanical shock or changes in the electrical load. 
 
Only the consequent implementation of protection devices and meticulous 
attention to the applicable rules and regulations for handling the respective 
equipment can prevent failures of electrostatic sensitive modules. 
 

Attention! 
• Before commissioning, the device has to be brought in environment 

temperature. 
• With condensation you may only switch on the device after complete 

dryness. 
• To prevent overheat during operation avoid direct sun contact of the 

device. 
• After opening of the control cabinet or panel, parts of the system are 

available that may lead dangerous voltage. 
• All signal connections require screened cables. 
• Signal cores may not be lead within a cable shaft of high-voltage cores. 
• Please take care for sufficient ground of the operating device. For this a 

ground screw is to be found at the backside of the device. 
 

Handling of 
electrostatic 
sensitive modules 
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Modules have to be shipped in the original packing material. 
 

 
When you are conducting measurements on electrostatic sensitive 
modules you should take the following precautions: 
• Floating instruments must be discharged before use. 
• Instruments must be grounded. 
Modifying electrostatic sensitive modules you should only use soldering 
irons with grounded tips. 
 
Attention! 
Personnel and instruments should be grounded when working on 
electrostatic sensitive modules. 
 

 
 

Shipping of 
electrostatic 
sensitive modules 

Measurements 
and alterations on 
electrostatic 
sensitive modules 
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Properties 
 

With the CC 03 there is access to the internal CPU. The CC 03 allows you 
to monitor and influence operating states and recent process values from 
internal CPU. The CC 03 may optionally be connected to the PLC system 
as PROFIBUS-DP slave (VIPA 603-2CC2x). 
For the comfortable entry of values and navigation, the CC 03 is provided 
with an integrated keyboard and a 2x20 character display. In addition there 
is a PLC-CPU which is programmable by STEP®7 from Siemens and an 
I/O periphery integrated to the CC 03. 
From the software side the connection happens by means of a CC 03 
project. The project may be created by means of the VIPA OP-Manager or 
by ProTool from Siemens. The project may be transferred from the PC to 
the CC 03 by MPI or MMC. During operation, the CC 03 communicates 
with the internal CPU and responds to the application processing of the 
CPU according to the engineered presetting. 
 

 
 
• Die-cast aluminum case, installation via non-looseable rocker arms 
• Protection type: front side IP65, back side IP20 
• Display with 2 x 20 characters 
• 128kB user memory, 4096 variables 
• MP2I interface for project engineering, CPU link-up and firmware update  
• Project engineering via VIPA OP-Manager or Siemens ProTool  
• Menus and input requests in 8 languages 
• Read and alter time and counter value, Monitoring of messages 
• Integrated PLC-CPU with Real-time clock und status-LEDs on the panel 
• MMC slot for external MMC storage medium 
• Integrated I/O periphery, expansion option via extension cable 
 

 
Type Order number Description 
CC 03 VIPA 603-2CC2x with integrated PROFIBUS-DP slave 
 VIPA 603-xCC21 with 16kB work memory/ 24kB load memory 
 VIPA 603-xCC22 with 24kB work memory/ 32kB load memory 
 VIPA 603-xCC23 with 24kB work memory/ 32kB load memory 
MPI cable VIPA 670-0KB00 OP/AG cable 0°/90° with PU-/Diagnostic port, 2.5m 

 

General 

CC 03 
603-xCC2x 

Order data 
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Structure 

 
 

At the front side of the Commander Compact CC 03 are the foil keyboard, 
the display with 2x20 characters and the Status LEDs of the CPU. 
 

[1] Display 
[2] Function keys 
[3] LEDs 

CC03

SHIFT

ESC

ENTER

1

4321
F1 F2 F3 F4

Commander Compact

9876

5
F5

0

,
+/-

PWR

RUN

STP

DE

SF

2

3

4

 

[4] Navigation keys 

 

At the CC 03 the connectors are located at back side. 
 

[1] Operating mode switch CPU 

[2] LEDs of the CPU part 

[3] MP2I slot 

[4] Slot for MMC storage  
module 

[5] Slot for DC 24V power supply 

[6] 9pin jack for system bus extension 

[7] RS485 PROFIBUS interface (only 
VIPA 603-2CC2x) 

[8] Ground screw 

.0

.1

.2

.3

.4

.5

.6

.7

1
2
3
4
5
6
7
8
9
I0

DO 8xDC24V 0,5A

L+
.0
.1
.2
.3
.4
.5
.6
.7
F

1
2
3
4
5
6
7
8
9
I0

DI 8xDC24V

X3

.0

.1

.2

.3

.4

.5

.6

.7

1
2
3
4
5
6
7
8
9
I0

DI 8xDC24V

X4 X5 X3X2

DO 8xDC24V 0,5A

L+
.0
.1
.2
.3
.4
.5
.6
.7
F

1
2
3
4
5
6
7
8
9
I0

X6

VIPA 603-2CC21

X1

DC24V

MMC

D
P

M
P
I

2

PW

SF

FC

MC

L+  

R

S

DE

RUN

STOP

MRST

+

M  
X 2
3 4M

3

4

6

7

2

1

5

9
8

G

[9] In-/output periphery 

 
 

 
 
 

 

Front view 

Back view 
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Components 
 

The CC 03 monitors values and messages via a STN text display with LED 
back lighting. It displays 2 rows with max. 20 characters with a line height 
of 5mm. 
 

At the front side is a foil keyboard with 18 short click keys. 8 keys are 
serving the navigation and 10 keys are for numeric input. 
The numeric keys F1 ... F5 are configurable as soft key with display 
depending functions via the VIPA project engineering tool. 
 

The CC 03 is provided with a MP2I (Multi-Point-Interface) for connection to 
your CPU via a MPI network and for connection to the PC for project 
engineering and firmware update. 
The MPI jack has the following pin assignment: 
 
9pin jack 

5

4

3

2

1

9

8

7

6

 

Pin Assignment 
1 reserved (must not be connected) 
2 M24V 
3 RxD/TxD-P (Line B) 
4 RTS 
5 M5V 
6 P5V 
7 P24V 
8 RxD/TxD-N (Line A) 
9 n.c.  

 

Via a 9pin RS485 interface, the CC 03DP is linked-up to PROFIBUS as DP 
slave. For project engineering in a PROFIBUS DP master the VIPA GSD 
file vipa04dx.gsd is necessary. 
The following picture illustrates the pin assignment of the interface: 
 
9pin jack 

5

4

3

2

1

9

8

7

6

 

Pin Assignment 
1 Screen 
2 n.c. 
3 RxD/TxD-P (Line B) 
4 RTS 
5 M5V 
6 P5V 
7 n.c. 
8 RxD/TxD-N (Line A) 
9 n.c.  

LC-Display 

Keyboard 

MP2I 

PROFIBUS- 
DP slave interface 
(only 603-2CC2x) 
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Every CC 03 has an integrated 9pin jack at the side. This jack allows you to 
extend the CC 03 with up to 4 System 100V expansion modules res. 
System 200V modules. Please regard that the maximum current load of 
800mA for the backplane bus must not be exceeded. 
To connect your modules, a special bus coupling cable is required that is 
available with order number VIPA 660-0KB00 at VIPA. For the connection, 
the bus cable is provided with a 9pin plug at one side and a 1tier bus 
coupler at the other. The project engineering of the expansion periphery 
happens in the hardware configurator from Siemens. 
 

Power supply 

DC24V

L+  +

M  M

 

The CC 03 has an integrated power supply. The power supply has to be 
provided with DC 24V (20.4 ... 28.8V). For this an according DC 24V slot is 
located at the back side. The power supply is protected against inverse 
polarity and overcurrent. 
Besides of the electronics, the supply voltage feeds also the optional 
components like output periphery, DP slave and bus extension. 
 
 

Note! 
Please regard that the bus extension may stand a max. of 800mA. 
 

The LEDs at the backside serve the status monitoring of the integrated 
CPU and the optional PROFIBUS-DP slave. All LEDs except of FC and MC 
are also at the front side. The following table shows color and usage: 
 
Label Color Description 
R Green CPU is in the operating mode RUN 
S Yellow CPU is in the operating mode STOP 
DE Yellow DE (Data Exchange) indicates PROFIBUS 

communication activity of the DP slave. (only VIPA 603-
2CC2x). 

PW Green CPU portion is supplied internal  
SF Red On at system error (hardware failure) 
FC Yellow On as soon as variables are forced* 
MC Yellow Shows access to MMC * 

* only back side  

 

With the operating mode switch you may choose between the operating 
modes STOP and RUN. The operating mode START-UP is processed 
automatically by the CPU between STOP and RUN. 
By means of the switch location Memory Reset (MRST) you request an 
overall reset res. a firmware update from a plugged MMC. 
 
 

Extension jack 

     

LEDs 

Operating mode 
switch 
RUN/STOP/MRST 
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MMC slot   
storage module 

X1

DC24V

MMC

MC

+

M

 
 

As external storage medium you may plug in a MMC storage module from 
VIPA (Order-No.: VIPA 953-0KX10). Access to the MMC always takes 
place after an overall reset and after PowerON. 
Also available at VIPA is an external MMC reading device (Order-No: VIPA 
950-0AD00). This allows you to write onto res. read your MMC at the PC. 
Please take care at insertion of the MMC that the flatted part is upside like 
shown in the picture. 

 
 
Note! 
Please regard that a write command is followed by an error message when 
no MMC is plugged. 
Although the data is stored in the internal Flash-ROM. 
 

Every CC-CPU has an internal accu for protecting the RAM at black-out. 
Additionally the internal real-time clock is buffered via the accu. 
The accu is loaded directly via the integrated power supply by means of 
special loading electronics and guarantees a buffer for max. 30 days.  
 

Attention! 
That the CC-CPU is able to switch to RUN, the accu has to be in good 
condition. 
If there is a defect at the accu, the CC-CPU switches to STOP and 
announces a sum error. In this case you should check the CC-CPU. Please 
contact VIPA for that purpose! 
 

Additional to the battery buffered RAM, the CC-CPU has got an internal 
Flash-ROM with the size of the corresponding load memory. 
Via the writing command PLC > Copy RAM to ROM from the destination 
system functions of the hardware configurator from Siemens, the contents 
of the load memory are transferred into the Flash-ROM and simultaneously 
to the MMC, if plugged in. 
The CC-CPU only accesses the contents of the Flash-ROM if the battery 
buffered RAM is empty. 
The Flash-ROM is not deleted by an overall reset. The Flash-ROM may be 
cleared by means of requesting an overall reset and then transferring the 
now empty load memory into the Flash-ROM via the PLC function Copy 
RAM to ROM. 
 

     

Battery buffer for 
clock and RAM 

 

Internal  
Flash-ROM 
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The CC 03 has an integrated I/O periphery which assignment is described 
in the following. Please regard that the output section has to be provided 
with external DC 24V! 
 

.0

.1

.2

.3

.4

.5

.6

.7

1
2
3
4
5
6
7
8
9
I0

DO 8xDC24V 0,5A

L+
.0
.1
.2
.3
.4
.5
.6
.7
F

1
2
3
4
5
6
7
8
9
I0

DI 8xDC24V

X3

.0

.1

.2

.3

.4

.5

.6

.7

1
2
3
4
5
6
7
8
9
I0

DI 8xDC24V

X4 X5 X3X2

DO 8xDC24V 0,5A

L+
.0
.1
.2
.3
.4
.5
.6
.7
F

1
2
3
4
5
6
7
8
9
I0

X6

VIPA 603-2CC21

X1

DC24V

MMC

D
P

M
P
I

2

PW

SF

FC

MC

L+  

R

S

DE

RUN

STOP

MRST

+

M  
X 2
3 4M

G

 

Position 1 
X3 

Position 2 
X4 

Position 3 
X5 

Position 4 
X6 

DI 8xDC 
24V 

DI 8xDC 
24V 

DO 8xDC 
24V 0.5A 

DO 8xDC 
24V 0.5A  

 

 
 
 

LED 
 

.0... .7 
 

Description 
 
LEDs (green)  
I+0.0 to I+0.7 
from ca. 15V on the 
signal "1" is recognized 
and the according LED is 
addressed 
 

Digital Input 
 

DI 8xDC24V

.0

.1

.2

.3

.4

.5

.6

.7

1
2
3
4
5
6
7
8
9
I0

 

Pin 
 
1 
2 
3 
4 
5 
6 
7 
8 
9 

10 

Assignment 
 
not used 
Input I+0.0 
Input I+0.1 
Input I+0.2 
Input I+0.3 
Input I+0.4 
Input I+0.5 
Input I+0.6 
Input I+0.7 
Ground 

 

LED 
 

L+ 
 
 

.0... .7 
 
 
 
 

F 
 

Description 
 
LED (green) 
Supply voltage is available 
 
LEDs (green) 
Q+0.0 to Q+0.7 
as soon as an output is 
active, the according LED 
is addressed 
LED (red) 
Error at overload, overheat 
or short circuits 

Digital Output 
 

DO 8xDC24V 0,5A 

L+
.0
.1
.2
.3
.4
.5
.6
.7
F

1
2
3
4
5
6
7
8
9
I0

 

Pin 
 
1 
2 
3 
4 
5 
6 
7 
8 
9 

10 

Assignment 
 
Supply voltage DC 24V 
Output Q+0.0 
Output Q+0.1 
Output Q+0.2 
Output Q+0.3 
Output Q+0.4 
Output Q+0.5 
Output Q+0.6 
Output Q+0.7 
Supply voltage ground 

I/O periphery  
DI 16xDC24V  
DO 16xDC24V 

Status monitor 
pin assignment 
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Connect the in-/outputs like shown in the picture: 
 
 

1

2

3

4

5

6

7

8

9

10 1M

1

2

3

4

5

6

7

8

9

10 2M

X3 X4

DC
24V

DC
24V

1

2

3

4

5

6

7

8

9

10 4M

4L+

X6

DC
24V

DC
24V

1

2

3

4

5

6

7

8

9

10 3M

3L+

X5

 
 

 
 

Input part Output part 
 

DC 24V

Minternal

V-Bus

Opto coupler
LED

Input

 

 

DC 24V

LED

Output

Minternal

V-Bus

Opto coupler

 
 
 
 
 

Circuit diagram 

Schematic 
diagram 
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Dimensions 
 

For the installation of the CC 03, an installation cutting with the dimensions 
156 x 78mm is required. 
 
Installation values for control cabinets and desks: 
Front panel width: 2.5 ... 6mm 
Installation cutting (W x H): 156 x 78mm 
Installation depth plus cabling 55mm 
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CC-CPU - Function security 
 

The CPU of the CC 03 includes security mechanisms like a watchdog 
(100ms) and a parameterizable cycle time surveillance (parameterizable 
min. 1ms) that stop res. execute a RESET at the CPU in case of an error 
and set it into a defined STOP state. 
 

The VIPA CPUs are developed function secure and have the following 
system properties: 
 

Event concerns Effect 
RUN → STOP general BASP (Befehls-Ausgabe-Sperre,  i.e. command 

output lock) is set. 
 central digital outputs The outputs are set to 0V. 
 central analog outputs The voltage supply for the output channels is 

switched off. 
 decentral outputs The outputs are set to 0V. 
 decentral inputs The inputs are read constantly from the slave and 

the recent values are put at disposal. 
STOP → RUN 
res. Power on 

general First the PII is deleted, the call of the OB100 
follows. After the execution of the OB, the BASP is 
set back and the cycle starts with:   
Delete PIQ → Read PII → OB1. 

 central analog outputs The behavior of the outputs at restart can be 
preset.  

 decentral inputs The inputs are read constantly from the slave and 
the recent values are put at disposal. 

RUN general The program execution happens cyclically and can 
therefore be foreseen:  
Read PII → OB1 → Write PIQ. 

 
 

PII: = Process image inputs 
PIQ: = Process image outputs 

  
 
 

 
 
 
 
 
 
 
 
 

Overview 

System properties 
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Technical data 
 

Order no. 603-1CC21 
Type CC 03, Commander 

Compact 
Display  
Number of rows 2  
Characters per row 20  
Character height 5 mm 
Type of display STN with LED backlighting 
OP functionality  
User memory 128 KB 
Number of variables 4096  
Language DE/EN/FR/ES/IT/SV/NO/DA
Operating controls  
Touchscreen - 
Mouse - 
Number of system keys 8  
Number of soft keys 5  
Technical data power supply  
Power supply (rated value) DC 24 V 
Power supply (permitted range) DC 20.4...28.8 V 
Reverse polarity protection  
Current consumption (no-load operation) 130 mA 
Current consumption (rated value) 1 A 
Inrush current 60 A 
I²t 0.35 A²s 
Max. current drain at backplane bus 0.8 A 
Power loss 8 W 
Reverse polarity protection  
Technical data digital inputs  
Number of inputs 16 
Cable length, shielded 1000 m 
Cable length, unshielded 600 m 
Rated load voltage DC 24 V 
Reverse polarity protection of rated load voltage  
Current consumption from load voltage L+ (without 
load) 

- 

Rated value DC 24 V 
Input voltage for signal "0" DC 0...5 V 
Input voltage for signal "1" DC 15...28.8 V 
Input current for signal "1" 7 mA 
Connection of Two-Wire-BEROs possible  
Max. permissible BERO quiescent current 1.5 mA 
Input delay of "0" to "1" 3 ms 
Input delay of "1" to "0" 3 ms 
Input characteristic curve IEC 61131-2, type 1 
Initial data size 2 Byte 
Technical data digital outputs  
Number of outputs 16 
Cable length, shielded 1000 m 
Cable length, unshielded 600 m 
Rated load voltage DC 24 V 
Reverse polarity protection of rated load voltage - 
Current consumption from load voltage L+ (without 
load) 

50 mA 

603-1CC21 
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Order no. 603-1CC21 
Total current per group, horizontal configuration, 
40°C 

4 A 

Total current per group, horizontal configuration, 
60°C 

4 A 

Total current per group, vertical configuration 4 A 
Output voltage signal "1" at min. current L+ (-125 mV) 
Output voltage signal "1" at max. current L+ (-0.8 V) 
Output current at signal "1", rated value 0.5 A 
Output delay of "0" to "1" max. 100 µs 
Output delay of "1" to "0" max. 350 µs 
Minimum load current - 
Lamp load 5 W 
Switching frequency with resistive load max. 1000 Hz 
Switching frequency with inductive load max. 0.5 Hz 
Switching frequency on lamp load max. 10 Hz 
Internal limitation of inductive shut-off voltage L+ (-52 V) 
Short-circuit protection of output yes, electronic 
Trigger level 1 A 
Output data size 2 Byte 
Technical data counters  
Number of counters - 
Counter width - 
Maximum input frequency - 
Maximum count frequency - 
Mode incremental encoder - 
Mode pulse / direction - 
Mode pulse - 
Mode frequency counter - 
Mode period measurement - 
Gate input available - 
Latch input available - 
Reset input available - 
Counter output available - 
Status information, alarms, diagnostics  
Status display yes 
Interrupts no 
Process alarm yes 
Diagnostic interrupt yes 
Diagnostic functions no 
Diagnostics information read-out possible 
Supply voltage display green LED 
Group error display red SF LED 
Channel error display red LED per group 
Isolation  
Between channels of groups to 8  
Between channels and backplane bus  
Insulation tested with DC 500 V 
Load and working memory  
Load memory, integrated 24 KB 
Load memory, maximum 24 KB 
Work memory, integrated 16 KB 
Work memory, maximal 16 KB 
Memory divided in 50% program / 50% data - 
Memory card slot MMC-Card with max. 512 

MB 
Hardware configuration  
Racks, max. 1  
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Order no. 603-1CC21 
Modules per rack, max. 4 
Number of integrated DP master 0  
Number of DP master via CP 4  
Operable function modules 4  
Operable communication modules PtP 4  
Operable communication modules LAN - 
Command processing times  
Bit instructions, min. 0.25 µs 
Word instruction, min. 1.2 µs 
Double integer arithmetic, min. 2.6 µs 
Floating-point arithmetic, min. 50 µs 
Timers/Counters and their retentive 
characteristics 

 

Number of S7 counters 256  
S7 counter remanence adjustable 0 up to 64 
S7 counter remanence adjustable C0 .. C7 
Number of S7 times 256  
S7 times remanence adjustable 0 up to 128 
S7 times remanence adjustable not retentive 
Data range and retentive characteristic  
Number of flags 8192 Bit 
Bit memories retentive characteristic adjustable adjustable 0 up to 256 
Bit memories retentive characteristic preset MB0 .. MB15 
Number of data blocks 2047  
Max. data blocks size 16 KB 
Number range DBs 1 ... 2047 
Max. local data size per execution level 1024 Byte 
Max. local data size per block 1024 Byte 
Blocks  
Number of OBs 14  
Maximum OB size 16 KB 
Total number DBs, FBs, FCs - 
Number of FBs 1024  
Maximum FB size 16 KB 
Number range FBs 0 ... 1023 
Number of FCs 1024  
Maximum FC size 16 KB 
Number range FCs 0 ... 1023 
Maximum nesting depth per priority class 8  
Maximum nesting depth additional within an error 
OB 

4  

Time  
Real-time clock buffered  
Clock buffered period (min.) 30 d 
Type of buffering  Vanadium Rechargeable 

Lithium Batterie 
Load time for 50% buffering period 20 h 
Load time for 100% buffering period 48 h 
Accuracy (max. deviation per day) 10 s 
Number of operating hours counter 8  
Clock synchronization - 
Synchronization via MPI no 
Synchronization via Ethernet (NTP) no 
Address areas (I/O)  
Input I/O address area 1024 Bit 
Output I/O address area 1024 Bit 
Process image adjustable - 
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Order no. 603-1CC21 
Input process image preset 128 Byte 
Output process image preset 128 Byte 
Input process image maximal 128 Byte 
Output process image maximal 128 Byte 
Digital inputs 8192  
Digital outputs 8192  
Digital inputs central 144  
Digital outputs central 144  
Integrated digital inputs 16 
Integrated digital outputs 16 
Analog inputs 512  
Analog outputs 512  
Analog inputs, central 32  
Analog outputs, central 16  
Integrated analog inputs - 
Integrated analog outputs - 
Communication functions  
PG/OP channel  
Global data communication  
Number of GD circuits, max. 4  
Size of GD packets, max. 22 Byte 
S7 basic communication  
S7 basic communication, user data per job 76 Byte 
S7 communication  
S7 communication as server  
S7 communication as client - 
S7 communication, user data per job 160 Byte 
Number of connections, max. 16  
Functionality Sub-D interfaces  
Type MP²I 
Type of interface RS485 
Connector Sub-D, 9-pin, female 
Electrically isolated - 
MPI  
MP²I (MPI/RS232)  
DP master - 
DP slave - 
Point-to-point interface - 
  
Type - 
Type of interface - 
Connector - 
Electrically isolated - 
MPI - 
MP²I (MPI/RS232) - 
DP master - 
DP slave - 
Point-to-point interface - 
Functionality MPI  
Number of connections, max. 16  
PG/OP channel  
Routing - 
Global data communication  
S7 basic communication  
S7 communication  
S7 communication as server  
S7 communication as client - 
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Order no. 603-1CC21 
Transmission speed, min. 19.2 kbit/s 
Transmission speed, max. 187.5 kbit/s 
Functionality PROFIBUS slave  
PG/OP channel - 
Routing - 
S7 communication - 
S7 communication as server - 
S7 communication as client - 
Direct data exchange (slave-to-slave 
communication) 

- 

DPV1 - 
Transmission speed, min. - 
Transmission speed, max. - 
Automatic detection of transmission speed - 
Transfer memory inputs, max. - 
Transfer memory outputs, max. - 
Address areas, max. - 
User data per address area, max. - 
Mechanical data  
Housing / Protection type  
Material die-cast aluminum 
Mounting via integrated pivoted lever 
Protect type front side IP 65 
Protect type back side IP 20 
Dimensions  
Front panel 187 x 90 x 6 mm 
Rear panel 154 x 77 x 55 mm 
Installation cut-out  
Width 156 mm 
Height 78 mm 
Minimum 2.5 mm 
Maximum front panel thickness 6 mm 
Weight 580 g 
Environmental conditions  
Operating temperature 0 °C to 60 °C 
Storage temperature -20 °C to 70 °C 
Certifications  
UL508 certification yes 
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Order no. 603-1CC22 
Type CC 03, Commander 

Compact 
Display  
Number of rows 2  
Characters per row 20  
Character height 5 mm 
Type of display STN with LED backlighting 
OP functionality  
User memory 128 KB 
Number of variables 4096  
Language DE/EN/FR/ES/IT/SV/NO/DA
Operating controls  
Touchscreen - 
Mouse - 
Number of system keys 8  
Number of soft keys 5  
Technical data power supply  
Power supply (rated value) DC 24 V 
Power supply (permitted range) DC 20.4...28.8 V 
Reverse polarity protection  
Current consumption (no-load operation) 130 mA 
Current consumption (rated value) 1 A 
Inrush current 60 A 
I²t 0.35 A²s 
Max. current drain at backplane bus 0.8 A 
Power loss 8 W 
Reverse polarity protection  
Technical data digital inputs  
Number of inputs 16 
Cable length, shielded 1000 m 
Cable length, unshielded 600 m 
Rated load voltage DC 24 V 
Reverse polarity protection of rated load voltage  
Current consumption from load voltage L+ (without 
load) 

- 

Rated value DC 24 V 
Input voltage for signal "0" DC 0...5 V 
Input voltage for signal "1" DC 15...28.8 V 
Input current for signal "1" 7 mA 
Connection of Two-Wire-BEROs possible  
Max. permissible BERO quiescent current 1.5 mA 
Input delay of "0" to "1" 3 ms 
Input delay of "1" to "0" 3 ms 
Input characteristic curve IEC 61131-2, type 1 
Initial data size 2 Byte 
Technical data digital outputs  
Number of outputs 16 
Cable length, shielded 1000 m 
Cable length, unshielded 600 m 
Rated load voltage DC 24 V 
Reverse polarity protection of rated load voltage - 
Current consumption from load voltage L+ (without 
load) 

50 mA 

Total current per group, horizontal configuration, 
40°C 

4 A 

Total current per group, horizontal configuration, 
60°C 

4 A 

603-1CC22 
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Order no. 603-1CC22 
Total current per group, vertical configuration 4 A 
Output voltage signal "1" at min. current L+ (-125 mV) 
Output voltage signal "1" at max. current L+ (-0.8 V) 
Output current at signal "1", rated value 0.5 A 
Output delay of "0" to "1" max. 100 µs 
Output delay of "1" to "0" max. 350 µs 
Minimum load current - 
Lamp load 5 W 
Switching frequency with resistive load max. 1000 Hz 
Switching frequency with inductive load max. 0.5 Hz 
Switching frequency on lamp load max. 10 Hz 
Internal limitation of inductive shut-off voltage L+ (-52 V) 
Short-circuit protection of output yes, electronic 
Trigger level 1 A 
Output data size 2 Byte 
Technical data counters  
Number of counters - 
Counter width - 
Maximum input frequency - 
Maximum count frequency - 
Mode incremental encoder - 
Mode pulse / direction - 
Mode pulse - 
Mode frequency counter - 
Mode period measurement - 
Gate input available - 
Latch input available - 
Reset input available - 
Counter output available - 
Status information, alarms, diagnostics  
Status display yes 
Interrupts no 
Process alarm yes 
Diagnostic interrupt yes 
Diagnostic functions no 
Diagnostics information read-out possible 
Supply voltage display green LED 
Group error display red SF LED 
Channel error display red LED per group 
Isolation  
Between channels of groups to 8  
Between channels and backplane bus  
Insulation tested with DC 500 V 
Load and working memory  
Load memory, integrated 32 KB 
Load memory, maximum 32 KB 
Work memory, integrated 24 KB 
Work memory, maximal 24 KB 
Memory divided in 50% program / 50% data - 
Memory card slot MMC-Card with max. 512 

MB 
Hardware configuration  
Racks, max. 1  
Modules per rack, max. 4 
Number of integrated DP master 0  
Number of DP master via CP 4  
Operable function modules 4  
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Order no. 603-1CC22 
Operable communication modules PtP 4  
Operable communication modules LAN - 
Command processing times  
Bit instructions, min. 0.25 µs 
Word instruction, min. 1.2 µs 
Double integer arithmetic, min. 2.6 µs 
Floating-point arithmetic, min. 50 µs 
Timers/Counters and their retentive 
characteristics 

 

Number of S7 counters 256  
S7 counter remanence adjustable 0 up to 64 
S7 counter remanence adjustable C0 .. C7 
Number of S7 times 256  
S7 times remanence adjustable 0 up to 128 
S7 times remanence adjustable not retentive 
Data range and retentive characteristic  
Number of flags 8192 Bit 
Bit memories retentive characteristic adjustable adjustable 0 up to 256 
Bit memories retentive characteristic preset MB0 .. MB15 
Number of data blocks 2047  
Max. data blocks size 16 KB 
Number range DBs 1 ... 2047 
Max. local data size per execution level 1024 Byte 
Max. local data size per block 1024 Byte 
Blocks  
Number of OBs 14  
Maximum OB size 16 KB 
Total number DBs, FBs, FCs - 
Number of FBs 1024  
Maximum FB size 16 KB 
Number range FBs 0 ... 1023 
Number of FCs 1024  
Maximum FC size 16 KB 
Number range FCs 0 ... 1023 
Maximum nesting depth per priority class 8  
Maximum nesting depth additional within an error 
OB 

4  

Time  
Real-time clock buffered  
Clock buffered period (min.) 30 d 
Type of buffering  Vanadium Rechargeable 

Lithium Batterie 
Load time for 50% buffering period 20 h 
Load time for 100% buffering period 48 h 
Accuracy (max. deviation per day) 10 s 
Number of operating hours counter 8  
Clock synchronization - 
Synchronization via MPI no 
Synchronization via Ethernet (NTP) no 
Address areas (I/O)  
Input I/O address area 1024 Bit 
Output I/O address area 1024 Bit 
Process image adjustable - 
Input process image preset 128 Byte 
Output process image preset 128 Byte 
Input process image maximal 128 Byte 
Output process image maximal 128 Byte 
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Order no. 603-1CC22 
Digital inputs 8192  
Digital outputs 8192  
Digital inputs central 144  
Digital outputs central 144  
Integrated digital inputs 16 
Integrated digital outputs 16 
Analog inputs 512  
Analog outputs 512  
Analog inputs, central 32  
Analog outputs, central 16  
Integrated analog inputs - 
Integrated analog outputs - 
Communication functions  
PG/OP channel  
Global data communication  
Number of GD circuits, max. 4  
Size of GD packets, max. 22 Byte 
S7 basic communication  
S7 basic communication, user data per job 76 Byte 
S7 communication  
S7 communication as server  
S7 communication as client - 
S7 communication, user data per job 160 Byte 
Number of connections, max. 16  
Functionality Sub-D interfaces  
Type MP²I 
Type of interface RS485 
Connector Sub-D, 9-pin, female 
Electrically isolated - 
MPI  
MP²I (MPI/RS232)  
DP master - 
DP slave - 
Point-to-point interface - 
  
Type - 
Type of interface - 
Connector - 
Electrically isolated - 
MPI - 
MP²I (MPI/RS232) - 
DP master - 
DP slave - 
Point-to-point interface - 
Functionality MPI  
Number of connections, max. 16  
PG/OP channel  
Routing - 
Global data communication  
S7 basic communication  
S7 communication  
S7 communication as server  
S7 communication as client - 
Transmission speed, min. 19.2 kbit/s 
Transmission speed, max. 187.5 kbit/s 
Functionality PROFIBUS slave  
PG/OP channel - 
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Order no. 603-1CC22 
Routing - 
S7 communication - 
S7 communication as server - 
S7 communication as client - 
Direct data exchange (slave-to-slave 
communication) 

- 

DPV1 - 
Transmission speed, min. - 
Transmission speed, max. - 
Automatic detection of transmission speed - 
Transfer memory inputs, max. - 
Transfer memory outputs, max. - 
Address areas, max. - 
User data per address area, max. - 
Mechanical data  
Housing / Protection type  
Material die-cast aluminum 
Mounting via integrated pivoted lever 
Protect type front side IP 65 
Protect type back side IP 20 
Dimensions  
Front panel 187 x 90 x 6 mm 
Rear panel 154 x 77 x 55 mm 
Installation cut-out  
Width 156 mm 
Height 78 mm 
Minimum 2.5 mm 
Maximum front panel thickness 6 mm 
Weight 580 g 
Environmental conditions  
Operating temperature 0 °C to 60 °C 
Storage temperature -20 °C to 70 °C 
Certifications  
UL508 certification yes 
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Order no. 603-1CC23 
Type CC 03, Commander 

Compact 
Display  
Number of rows 2  
Characters per row 20  
Character height 5 mm 
Type of display STN with LED backlighting 
OP functionality  
User memory 128 KB 
Number of variables 4096  
Language DE/EN/FR/ES/IT/SV/NO/DA
Operating controls  
Touchscreen - 
Mouse - 
Number of system keys 8  
Number of soft keys 5  
Technical data power supply  
Power supply (rated value) DC 24 V 
Power supply (permitted range) DC 20.4...28.8 V 
Reverse polarity protection  
Current consumption (no-load operation) 130 mA 
Current consumption (rated value) 1 A 
Inrush current 60 A 
I²t 0.35 A²s 
Max. current drain at backplane bus 0.8 A 
Power loss 8 W 
Reverse polarity protection  
Technical data digital inputs  
Number of inputs 16 
Cable length, shielded 1000 m 
Cable length, unshielded 600 m 
Rated load voltage DC 24 V 
Reverse polarity protection of rated load voltage  
Current consumption from load voltage L+ (without 
load) 

- 

Rated value DC 24 V 
Input voltage for signal "0" DC 0...5 V 
Input voltage for signal "1" DC 15...28.8 V 
Input current for signal "1" 7 mA 
Connection of Two-Wire-BEROs possible  
Max. permissible BERO quiescent current 1.5 mA 
Input delay of "0" to "1" 3 ms 
Input delay of "1" to "0" 3 ms 
Input characteristic curve IEC 61131-2, type 1 
Initial data size 2 Byte 
Technical data digital outputs  
Number of outputs 16 
Cable length, shielded 1000 m 
Cable length, unshielded 600 m 
Rated load voltage DC 24 V 
Reverse polarity protection of rated load voltage - 
Current consumption from load voltage L+ (without 
load) 

50 mA 

Total current per group, horizontal configuration, 
40°C 

4 A 

Total current per group, horizontal configuration, 
60°C 

4 A 

603-1CC23 
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Order no. 603-1CC23 
Total current per group, vertical configuration 4 A 
Output voltage signal "1" at min. current L+ (-125 mV) 
Output voltage signal "1" at max. current L+ (-0.8 V) 
Output current at signal "1", rated value 0.5 A 
Output delay of "0" to "1" max. 100 µs 
Output delay of "1" to "0" max. 350 µs 
Minimum load current - 
Lamp load 5 W 
Switching frequency with resistive load max. 1000 Hz 
Switching frequency with inductive load max. 0.5 Hz 
Switching frequency on lamp load max. 10 Hz 
Internal limitation of inductive shut-off voltage L+ (-52 V) 
Short-circuit protection of output yes, electronic 
Trigger level 1 A 
Output data size 2 Byte 
Technical data counters  
Number of counters - 
Counter width - 
Maximum input frequency - 
Maximum count frequency - 
Mode incremental encoder - 
Mode pulse / direction - 
Mode pulse - 
Mode frequency counter - 
Mode period measurement - 
Gate input available - 
Latch input available - 
Reset input available - 
Counter output available - 
Status information, alarms, diagnostics  
Status display yes 
Interrupts no 
Process alarm yes 
Diagnostic interrupt yes 
Diagnostic functions no 
Diagnostics information read-out possible 
Supply voltage display green LED 
Group error display red SF LED 
Channel error display red LED per group 
Isolation  
Between channels of groups to 8  
Between channels and backplane bus  
Insulation tested with DC 500 V 
Load and working memory  
Load memory, integrated 40 KB 
Load memory, maximum 40 KB 
Work memory, integrated 32 KB 
Work memory, maximal 32 KB 
Memory divided in 50% program / 50% data - 
Memory card slot MMC-Card with max. 512 

MB 
Hardware configuration  
Racks, max. 1  
Modules per rack, max. 4 
Number of integrated DP master 0  
Number of DP master via CP 4  
Operable function modules 4  
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Order no. 603-1CC23 
Operable communication modules PtP 4  
Operable communication modules LAN - 
Command processing times  
Bit instructions, min. 0.25 µs 
Word instruction, min. 1.2 µs 
Double integer arithmetic, min. 2.6 µs 
Floating-point arithmetic, min. 50 µs 
Timers/Counters and their retentive 
characteristics 

 

Number of S7 counters 256  
S7 counter remanence adjustable 0 up to 64 
S7 counter remanence adjustable C0 .. C7 
Number of S7 times 256  
S7 times remanence adjustable 0 up to 128 
S7 times remanence adjustable not retentive 
Data range and retentive characteristic  
Number of flags 8192 Bit 
Bit memories retentive characteristic adjustable adjustable 0 up to 256 
Bit memories retentive characteristic preset MB0 .. MB15 
Number of data blocks 2047  
Max. data blocks size 16 KB 
Number range DBs 1 ... 2047 
Max. local data size per execution level 1024 Byte 
Max. local data size per block 1024 Byte 
Blocks  
Number of OBs 14  
Maximum OB size 16 KB 
Total number DBs, FBs, FCs - 
Number of FBs 1024  
Maximum FB size 16 KB 
Number range FBs 0 ... 1023 
Number of FCs 1024  
Maximum FC size 16 KB 
Number range FCs 0 ... 1023 
Maximum nesting depth per priority class 8  
Maximum nesting depth additional within an error 
OB 

4  

Time  
Real-time clock buffered  
Clock buffered period (min.) 30 d 
Type of buffering  Vanadium Rechargeable 

Lithium Batterie 
Load time for 50% buffering period 20 h 
Load time for 100% buffering period 48 h 
Accuracy (max. deviation per day) 10 s 
Number of operating hours counter 8  
Clock synchronization - 
Synchronization via MPI no 
Synchronization via Ethernet (NTP) no 
Address areas (I/O)  
Input I/O address area 1024 Bit 
Output I/O address area 1024 Bit 
Process image adjustable - 
Input process image preset 128 Byte 
Output process image preset 128 Byte 
Input process image maximal 128 Byte 
Output process image maximal 128 Byte 
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Order no. 603-1CC23 
Digital inputs 8192  
Digital outputs 8192  
Digital inputs central 144  
Digital outputs central 144  
Integrated digital inputs 16 
Integrated digital outputs 16 
Analog inputs 512  
Analog outputs 512  
Analog inputs, central 32  
Analog outputs, central 16  
Integrated analog inputs - 
Integrated analog outputs - 
Communication functions  
PG/OP channel  
Global data communication  
Number of GD circuits, max. 4  
Size of GD packets, max. 22 Byte 
S7 basic communication  
S7 basic communication, user data per job 76 Byte 
S7 communication  
S7 communication as server  
S7 communication as client - 
S7 communication, user data per job 160 Byte 
Number of connections, max. 16  
Functionality Sub-D interfaces  
Type MP²I 
Type of interface RS485 
Connector Sub-D, 9-pin, female 
Electrically isolated - 
MPI  
MP²I (MPI/RS232)  
DP master - 
DP slave - 
Point-to-point interface - 
  
Type - 
Type of interface - 
Connector - 
Electrically isolated - 
MPI - 
MP²I (MPI/RS232) - 
DP master - 
DP slave - 
Point-to-point interface - 
Functionality MPI  
Number of connections, max. 16  
PG/OP channel  
Routing - 
Global data communication  
S7 basic communication  
S7 communication  
S7 communication as server  
S7 communication as client - 
Transmission speed, min. 19.2 kbit/s 
Transmission speed, max. 187.5 kbit/s 
Functionality PROFIBUS slave  
PG/OP channel - 
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Order no. 603-1CC23 
Routing - 
S7 communication - 
S7 communication as server - 
S7 communication as client - 
Direct data exchange (slave-to-slave 
communication) 

- 

DPV1 - 
Transmission speed, min. - 
Transmission speed, max. - 
Automatic detection of transmission speed - 
Transfer memory inputs, max. - 
Transfer memory outputs, max. - 
Address areas, max. - 
User data per address area, max. - 
Mechanical data  
Housing / Protection type  
Material die-cast aluminum 
Mounting via integrated pivoted lever 
Protect type front side IP 65 
Protect type back side IP 20 
Dimensions  
Front panel 187 x 90 x 6 mm 
Rear panel 154 x 77 x 55 mm 
Installation cut-out  
Width 156 mm 
Height 78 mm 
Minimum 2.5 mm 
Maximum front panel thickness 6 mm 
Weight 580 g 
Environmental conditions  
Operating temperature 0 °C to 60 °C 
Storage temperature -20 °C to 70 °C 
Certifications  
UL508 certification yes 
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Order no. 603-2CC21 
Type CC 03DP, Commander 

Compact, PROFIBUS-DP 
slave 

Display  
Number of rows 2  
Characters per row 20  
Character height 5 mm 
Type of display STN with LED backlighting 
OP functionality  
User memory 128 KB 
Number of variables 4096  
Language DE/EN/FR/ES/IT/SV/NO/DA
Operating controls  
Touchscreen - 
Mouse - 
Number of system keys 8  
Number of soft keys 5  
Technical data power supply  
Power supply (rated value) DC 24 V 
Power supply (permitted range) DC 20.4...28.8 V 
Reverse polarity protection  
Current consumption (no-load operation) 150 mA 
Current consumption (rated value) 1 A 
Inrush current 60 A 
I²t 0.35 A²s 
Max. current drain at backplane bus 0.8 A 
Power loss 8 W 
Reverse polarity protection  
Technical data digital inputs  
Number of inputs 16 
Cable length, shielded 1000 m 
Cable length, unshielded 600 m 
Rated load voltage DC 24 V 
Reverse polarity protection of rated load voltage  
Current consumption from load voltage L+ (without 
load) 

- 

Rated value DC 24 V 
Input voltage for signal "0" DC 0...5 V 
Input voltage for signal "1" DC 15...28.8 V 
Input current for signal "1" 7 mA 
Connection of Two-Wire-BEROs possible  
Max. permissible BERO quiescent current 1.5 mA 
Input delay of "0" to "1" 3 ms 
Input delay of "1" to "0" 3 ms 
Input characteristic curve IEC 61131-2, type 1 
Initial data size 2 Byte 
Technical data digital outputs  
Number of outputs 16 
Cable length, shielded 1000 m 
Cable length, unshielded 600 m 
Rated load voltage DC 24 V 
Reverse polarity protection of rated load voltage - 
Current consumption from load voltage L+ (without 
load) 

50 mA 

Total current per group, horizontal configuration, 
40°C 

4 A 

Total current per group, horizontal configuration, 4 A 

603-2CC21 
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60°C 
Total current per group, vertical configuration 4 A 
Output voltage signal "1" at min. current L+ (-125 mV) 
Output voltage signal "1" at max. current L+ (-0.8 V) 
Output current at signal "1", rated value 0.5 A 
Output delay of "0" to "1" max. 100 µs 
Output delay of "1" to "0" max. 350 µs 
Minimum load current - 
Lamp load 5 W 
Switching frequency with resistive load max. 1000 Hz 
Switching frequency with inductive load max. 0.5 Hz 
Switching frequency on lamp load max. 10 Hz 
Internal limitation of inductive shut-off voltage L+ (-52 V) 
Short-circuit protection of output yes, electronic 
Trigger level 1 A 
Output data size 2 Byte 
Technical data counters  
Number of counters - 
Counter width - 
Maximum input frequency - 
Maximum count frequency - 
Mode incremental encoder - 
Mode pulse / direction - 
Mode pulse - 
Mode frequency counter - 
Mode period measurement - 
Gate input available - 
Latch input available - 
Reset input available - 
Counter output available - 
Status information, alarms, diagnostics  
Status display yes 
Interrupts no 
Process alarm yes 
Diagnostic interrupt yes 
Diagnostic functions no 
Diagnostics information read-out possible 
Supply voltage display green LED 
Group error display red SF LED 
Channel error display red LED per group 
Isolation  
Between channels of groups to 8  
Between channels and backplane bus  
Insulation tested with DC 500 V 
Load and working memory  
Load memory, integrated 24 KB 
Load memory, maximum 24 KB 
Work memory, integrated 16 KB 
Work memory, maximal 16 KB 
Memory divided in 50% program / 50% data - 
Memory card slot MMC-Card with max. 512 

MB 
Hardware configuration  
Racks, max. 1  
Modules per rack, max. 4 
Number of integrated DP master 0  
Number of DP master via CP 4  
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Operable function modules 4  
Operable communication modules PtP 4  
Operable communication modules LAN - 
Command processing times  
Bit instructions, min. 0.25 µs 
Word instruction, min. 1.2 µs 
Double integer arithmetic, min. 2.6 µs 
Floating-point arithmetic, min. 50 µs 
Timers/Counters and their retentive 
characteristics 

 

Number of S7 counters 256  
S7 counter remanence adjustable 0 up to 64 
S7 counter remanence adjustable C0 .. C7 
Number of S7 times 256  
S7 times remanence adjustable 0 up to 128 
S7 times remanence adjustable not retentive 
Data range and retentive characteristic  
Number of flags 8192 Bit 
Bit memories retentive characteristic adjustable adjustable 0 up to 256 
Bit memories retentive characteristic preset MB0 .. MB15 
Number of data blocks 2047  
Max. data blocks size 16 KB 
Number range DBs 1 ... 2047 
Max. local data size per execution level 1024 Byte 
Max. local data size per block 1024 Byte 
Blocks  
Number of OBs 14  
Maximum OB size 16 KB 
Total number DBs, FBs, FCs - 
Number of FBs 1024  
Maximum FB size 16 KB 
Number range FBs 0 ... 1023 
Number of FCs 1024  
Maximum FC size 16 KB 
Number range FCs 0 ... 1023 
Maximum nesting depth per priority class 8  
Maximum nesting depth additional within an error 
OB 

4  

Time  
Real-time clock buffered  
Clock buffered period (min.) 30 d 
Type of buffering  Vanadium Rechargeable 

Lithium Batterie 
Load time for 50% buffering period 20 h 
Load time for 100% buffering period 48 h 
Accuracy (max. deviation per day) 10 s 
Number of operating hours counter 8  
Clock synchronization - 
Synchronization via MPI no 
Synchronization via Ethernet (NTP) no 
Address areas (I/O)  
Input I/O address area 1024 Bit 
Output I/O address area 1024 Bit 
Process image adjustable - 
Input process image preset 128 Byte 
Output process image preset 128 Byte 
Input process image maximal 128 Byte 
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Output process image maximal 128 Byte 
Digital inputs 8192  
Digital outputs 8192  
Digital inputs central 144  
Digital outputs central 144  
Integrated digital inputs 16 
Integrated digital outputs 16 
Analog inputs 512  
Analog outputs 512  
Analog inputs, central 32  
Analog outputs, central 16  
Integrated analog inputs - 
Integrated analog outputs - 
Communication functions  
PG/OP channel  
Global data communication  
Number of GD circuits, max. 4  
Size of GD packets, max. 22 Byte 
S7 basic communication  
S7 basic communication, user data per job 76 Byte 
S7 communication  
S7 communication as server  
S7 communication as client - 
S7 communication, user data per job 160 Byte 
Number of connections, max. 16  
Functionality Sub-D interfaces  
Type MP²I 
Type of interface RS485 
Connector Sub-D, 9-pin, female 
Electrically isolated - 
MPI  
MP²I (MPI/RS232)  
DP master - 
DP slave - 
Point-to-point interface - 
  
Type DP 
Type of interface RS485 
Connector Sub-D, 9-pin, female 
Electrically isolated  
MPI - 
MP²I (MPI/RS232) - 
DP master - 
DP slave yes 
Point-to-point interface - 
Functionality MPI  
Number of connections, max. 16  
PG/OP channel  
Routing - 
Global data communication  
S7 basic communication  
S7 communication  
S7 communication as server  
S7 communication as client - 
Transmission speed, min. 19.2 kbit/s 
Transmission speed, max. 187.5 kbit/s 
Functionality PROFIBUS slave  
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PG/OP channel - 
Routing - 
S7 communication - 
S7 communication as server - 
S7 communication as client - 
Direct data exchange (slave-to-slave 
communication) 

- 

DPV1 - 
Transmission speed, min. 9.6 kbit/s 
Transmission speed, max. 12 Mbit/s 
Automatic detection of transmission speed  
Transfer memory inputs, max. 64 Byte 
Transfer memory outputs, max. 64 Byte 
Address areas, max. - 
User data per address area, max. - 
Mechanical data  
Housing / Protection type  
Material die-cast aluminum 
Mounting via integrated pivoted lever 
Protect type front side IP 65 
Protect type back side IP 20 
Dimensions  
Front panel 187 x 90 x 6 mm 
Rear panel 154 x 77 x 55 mm 
Installation cut-out  
Width 156 mm 
Height 78 mm 
Minimum 2.5 mm 
Maximum front panel thickness 6 mm 
Weight 600 g 
Environmental conditions  
Operating temperature 0 °C to 60 °C 
Storage temperature -20 °C to 70 °C 
Certifications  
UL508 certification yes 
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Type CC 03DP, Commander 

Compact, PROFIBUS-DP 
slave 

Display  
Number of rows 2  
Characters per row 20  
Character height 5 mm 
Type of display STN with LED backlighting 
OP functionality  
User memory 128 KB 
Number of variables 4096  
Language DE/EN/FR/ES/IT/SV/NO/DA
Operating controls  
Touchscreen - 
Mouse - 
Number of system keys 8  
Number of soft keys 5  
Technical data power supply  
Power supply (rated value) DC 24 V 
Power supply (permitted range) DC 20.4...28.8 V 
Reverse polarity protection  
Current consumption (no-load operation) 150 mA 
Current consumption (rated value) 1 A 
Inrush current 60 A 
I²t 0.35 A²s 
Max. current drain at backplane bus 0.8 A 
Power loss 8 W 
Reverse polarity protection  
Technical data digital inputs  
Number of inputs 16 
Cable length, shielded 1000 m 
Cable length, unshielded 600 m 
Rated load voltage DC 24 V 
Reverse polarity protection of rated load voltage  
Current consumption from load voltage L+ (without 
load) 

- 

Rated value DC 24 V 
Input voltage for signal "0" DC 0...5 V 
Input voltage for signal "1" DC 15...28.8 V 
Input current for signal "1" 7 mA 
Connection of Two-Wire-BEROs possible  
Max. permissible BERO quiescent current 1.5 mA 
Input delay of "0" to "1" 3 ms 
Input delay of "1" to "0" 3 ms 
Input characteristic curve IEC 61131-2, type 1 
Initial data size 2 Byte 
Technical data digital outputs  
Number of outputs 16 
Cable length, shielded 1000 m 
Cable length, unshielded 600 m 
Rated load voltage DC 24 V 
Reverse polarity protection of rated load voltage - 
Current consumption from load voltage L+ (without 
load) 

50 mA 

Total current per group, horizontal configuration, 
40°C 

4 A 

Total current per group, horizontal configuration, 4 A 

603-2CC22 
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60°C 
Total current per group, vertical configuration 4 A 
Output voltage signal "1" at min. current L+ (-125 mV) 
Output voltage signal "1" at max. current L+ (-0.8 V) 
Output current at signal "1", rated value 0.5 A 
Output delay of "0" to "1" max. 100 µs 
Output delay of "1" to "0" max. 350 µs 
Minimum load current - 
Lamp load 5 W 
Switching frequency with resistive load max. 1000 Hz 
Switching frequency with inductive load max. 0.5 Hz 
Switching frequency on lamp load max. 10 Hz 
Internal limitation of inductive shut-off voltage L+ (-52 V) 
Short-circuit protection of output yes, electronic 
Trigger level 1 A 
Output data size 2 Byte 
Technical data counters  
Number of counters - 
Counter width - 
Maximum input frequency - 
Maximum count frequency - 
Mode incremental encoder - 
Mode pulse / direction - 
Mode pulse - 
Mode frequency counter - 
Mode period measurement - 
Gate input available - 
Latch input available - 
Reset input available - 
Counter output available - 
Status information, alarms, diagnostics  
Status display yes 
Interrupts no 
Process alarm yes 
Diagnostic interrupt yes 
Diagnostic functions no 
Diagnostics information read-out possible 
Supply voltage display green LED 
Group error display red SF LED 
Channel error display red LED per group 
Isolation  
Between channels of groups to 8  
Between channels and backplane bus  
Insulation tested with DC 500 V 
Load and working memory  
Load memory, integrated 32 KB 
Load memory, maximum 32 KB 
Work memory, integrated 24 KB 
Work memory, maximal 24 KB 
Memory divided in 50% program / 50% data - 
Memory card slot MMC-Card with max. 512 

MB 
Hardware configuration  
Racks, max. 1  
Modules per rack, max. 4 
Number of integrated DP master 0  
Number of DP master via CP 4  



Manual VIPA HMI Chapter 1   Hardware description 

HB116E - CC 03 - Rev. 15/04  1-35 

Order no. 603-2CC22 
Operable function modules 4  
Operable communication modules PtP 4  
Operable communication modules LAN - 
Command processing times  
Bit instructions, min. 0.25 µs 
Word instruction, min. 1.2 µs 
Double integer arithmetic, min. 2.6 µs 
Floating-point arithmetic, min. 50 µs 
Timers/Counters and their retentive 
characteristics 

 

Number of S7 counters 256  
S7 counter remanence adjustable 0 up to 64 
S7 counter remanence adjustable C0 .. C7 
Number of S7 times 256  
S7 times remanence adjustable 0 up to 128 
S7 times remanence adjustable not retentive 
Data range and retentive characteristic  
Number of flags 8192 Bit 
Bit memories retentive characteristic adjustable adjustable 0 up to 256 
Bit memories retentive characteristic preset MB0 .. MB15 
Number of data blocks 2047  
Max. data blocks size 16 KB 
Number range DBs 1 ... 2047 
Max. local data size per execution level 1024 Byte 
Max. local data size per block 1024 Byte 
Blocks  
Number of OBs 14  
Maximum OB size 16 KB 
Total number DBs, FBs, FCs - 
Number of FBs 1024  
Maximum FB size 16 KB 
Number range FBs 0 ... 1023 
Number of FCs 1024  
Maximum FC size 16 KB 
Number range FCs 0 ... 1023 
Maximum nesting depth per priority class 8  
Maximum nesting depth additional within an error 
OB 

4  

Time  
Real-time clock buffered  
Clock buffered period (min.) 30 d 
Type of buffering  Vanadium Rechargeable 

Lithium Batterie 
Load time for 50% buffering period 20 h 
Load time for 100% buffering period 48 h 
Accuracy (max. deviation per day) 10 s 
Number of operating hours counter 8  
Clock synchronization - 
Synchronization via MPI no 
Synchronization via Ethernet (NTP) no 
Address areas (I/O)  
Input I/O address area 1024 Bit 
Output I/O address area 1024 Bit 
Process image adjustable - 
Input process image preset 128 Byte 
Output process image preset 128 Byte 
Input process image maximal 128 Byte 



Chapter 1   Hardware description Manual VIPA HMI 

1-36  HB116E - CC 03 - Rev. 15/04 

Order no. 603-2CC22 
Output process image maximal 128 Byte 
Digital inputs 8192  
Digital outputs 8192  
Digital inputs central 144  
Digital outputs central 144  
Integrated digital inputs 16 
Integrated digital outputs 16 
Analog inputs 512  
Analog outputs 512  
Analog inputs, central 32  
Analog outputs, central 16  
Integrated analog inputs - 
Integrated analog outputs - 
Communication functions  
PG/OP channel  
Global data communication  
Number of GD circuits, max. 4  
Size of GD packets, max. 22 Byte 
S7 basic communication  
S7 basic communication, user data per job 76 Byte 
S7 communication  
S7 communication as server  
S7 communication as client - 
S7 communication, user data per job 160 Byte 
Number of connections, max. 16  
Functionality Sub-D interfaces  
Type MP²I 
Type of interface RS485 
Connector Sub-D, 9-pin, female 
Electrically isolated - 
MPI  
MP²I (MPI/RS232)  
DP master - 
DP slave - 
Point-to-point interface - 
  
Type DP 
Type of interface RS485 
Connector Sub-D, 9-pin, female 
Electrically isolated  
MPI - 
MP²I (MPI/RS232) - 
DP master - 
DP slave yes 
Point-to-point interface - 
Functionality MPI  
Number of connections, max. 16  
PG/OP channel  
Routing - 
Global data communication  
S7 basic communication  
S7 communication  
S7 communication as server  
S7 communication as client - 
Transmission speed, min. 19.2 kbit/s 
Transmission speed, max. 187.5 kbit/s 
Functionality PROFIBUS slave  
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PG/OP channel - 
Routing - 
S7 communication - 
S7 communication as server - 
S7 communication as client - 
Direct data exchange (slave-to-slave 
communication) 

- 

DPV1 - 
Transmission speed, min. 9.6 kbit/s 
Transmission speed, max. 12 Mbit/s 
Automatic detection of transmission speed  
Transfer memory inputs, max. 64 Byte 
Transfer memory outputs, max. 64 Byte 
Address areas, max. - 
User data per address area, max. - 
Mechanical data  
Housing / Protection type  
Material die-cast aluminum 
Mounting via integrated pivoted lever 
Protect type front side IP 65 
Protect type back side IP 20 
Dimensions  
Front panel 187 x 90 x 6 mm 
Rear panel 154 x 77 x 55 mm 
Installation cut-out  
Width 156 mm 
Height 78 mm 
Minimum 2.5 mm 
Maximum front panel thickness 6 mm 
Weight 600 g 
Environmental conditions  
Operating temperature 0 °C to 60 °C 
Storage temperature -20 °C to 70 °C 
Certifications  
UL508 certification yes 
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Order no. 603-2CC23 
Type CC 03DP, Commander 

Compact, PROFIBUS-DP 
slave 

Display  
Number of rows 2  
Characters per row 20  
Character height 5 mm 
Type of display STN with LED backlighting 
OP functionality  
User memory 128 KB 
Number of variables 4096  
Language DE/EN/FR/ES/IT/SV/NO/DA
Operating controls  
Touchscreen - 
Mouse - 
Number of system keys 8  
Number of soft keys 5  
Technical data power supply  
Power supply (rated value) DC 24 V 
Power supply (permitted range) DC 20.4...28.8 V 
Reverse polarity protection  
Current consumption (no-load operation) 150 mA 
Current consumption (rated value) 1 A 
Inrush current 60 A 
I²t 0.35 A²s 
Max. current drain at backplane bus 0.8 A 
Power loss 8 W 
Reverse polarity protection  
Technical data digital inputs  
Number of inputs 16 
Cable length, shielded 1000 m 
Cable length, unshielded 600 m 
Rated load voltage DC 24 V 
Reverse polarity protection of rated load voltage  
Current consumption from load voltage L+ (without 
load) 

- 

Rated value DC 24 V 
Input voltage for signal "0" DC 0...5 V 
Input voltage for signal "1" DC 15...28.8 V 
Input current for signal "1" 7 mA 
Connection of Two-Wire-BEROs possible  
Max. permissible BERO quiescent current 1.5 mA 
Input delay of "0" to "1" 3 ms 
Input delay of "1" to "0" 3 ms 
Input characteristic curve IEC 61131-2, type 1 
Initial data size 2 Byte 
Technical data digital outputs  
Number of outputs 16 
Cable length, shielded 1000 m 
Cable length, unshielded 600 m 
Rated load voltage DC 24 V 
Reverse polarity protection of rated load voltage - 
Current consumption from load voltage L+ (without 
load) 

50 mA 

Total current per group, horizontal configuration, 
40°C 

4 A 

Total current per group, horizontal configuration, 4 A 

603-2CC23    
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60°C 
Total current per group, vertical configuration 4 A 
Output voltage signal "1" at min. current L+ (-125 mV) 
Output voltage signal "1" at max. current L+ (-0.8 V) 
Output current at signal "1", rated value 0.5 A 
Output delay of "0" to "1" max. 100 µs 
Output delay of "1" to "0" max. 350 µs 
Minimum load current - 
Lamp load 5 W 
Switching frequency with resistive load max. 1000 Hz 
Switching frequency with inductive load max. 0.5 Hz 
Switching frequency on lamp load max. 10 Hz 
Internal limitation of inductive shut-off voltage L+ (-52 V) 
Short-circuit protection of output yes, electronic 
Trigger level 1 A 
Output data size 2 Byte 
Technical data counters  
Number of counters - 
Counter width - 
Maximum input frequency - 
Maximum count frequency - 
Mode incremental encoder - 
Mode pulse / direction - 
Mode pulse - 
Mode frequency counter - 
Mode period measurement - 
Gate input available - 
Latch input available - 
Reset input available - 
Counter output available - 
Status information, alarms, diagnostics  
Status display yes 
Interrupts no 
Process alarm yes 
Diagnostic interrupt yes 
Diagnostic functions no 
Diagnostics information read-out possible 
Supply voltage display green LED 
Group error display red SF LED 
Channel error display red LED per group 
Isolation  
Between channels of groups to 8  
Between channels and backplane bus  
Insulation tested with DC 500 V 
Load and working memory  
Load memory, integrated 40 KB 
Load memory, maximum 40 KB 
Work memory, integrated 32 KB 
Work memory, maximal 32 KB 
Memory divided in 50% program / 50% data - 
Memory card slot MMC-Card with max. 512 

MB 
Hardware configuration  
Racks, max. 1  
Modules per rack, max. 4 
Number of integrated DP master 0  
Number of DP master via CP 4  
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Operable function modules 4  
Operable communication modules PtP 4  
Operable communication modules LAN - 
Command processing times  
Bit instructions, min. 0.25 µs 
Word instruction, min. 1.2 µs 
Double integer arithmetic, min. 2.6 µs 
Floating-point arithmetic, min. 50 µs 
Timers/Counters and their retentive 
characteristics 

 

Number of S7 counters 256  
S7 counter remanence adjustable 0 up to 64 
S7 counter remanence adjustable C0 .. C7 
Number of S7 times 256  
S7 times remanence adjustable 0 up to 128 
S7 times remanence adjustable not retentive 
Data range and retentive characteristic  
Number of flags 8192 Bit 
Bit memories retentive characteristic adjustable adjustable 0 up to 256 
Bit memories retentive characteristic preset MB0 .. MB15 
Number of data blocks 2047  
Max. data blocks size 16 KB 
Number range DBs 1 ... 2047 
Max. local data size per execution level 1024 Byte 
Max. local data size per block 1024 Byte 
Blocks  
Number of OBs 14  
Maximum OB size 16 KB 
Total number DBs, FBs, FCs - 
Number of FBs 1024  
Maximum FB size 16 KB 
Number range FBs 0 ... 1023 
Number of FCs 1024  
Maximum FC size 16 KB 
Number range FCs 0 ... 1023 
Maximum nesting depth per priority class 8  
Maximum nesting depth additional within an error 
OB 

4  

Time  
Real-time clock buffered  
Clock buffered period (min.) 30 d 
Type of buffering  Vanadium Rechargeable 

Lithium Batterie 
Load time for 50% buffering period 20 h 
Load time for 100% buffering period 48 h 
Accuracy (max. deviation per day) 10 s 
Number of operating hours counter 8  
Clock synchronization - 
Synchronization via MPI no 
Synchronization via Ethernet (NTP) no 
Address areas (I/O)  
Input I/O address area 1024 Bit 
Output I/O address area 1024 Bit 
Process image adjustable - 
Input process image preset 128 Byte 
Output process image preset 128 Byte 
Input process image maximal 128 Byte 
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Output process image maximal 128 Byte 
Digital inputs 8192  
Digital outputs 8192  
Digital inputs central 144  
Digital outputs central 144  
Integrated digital inputs 16 
Integrated digital outputs 16 
Analog inputs 512  
Analog outputs 512  
Analog inputs, central 32  
Analog outputs, central 16  
Integrated analog inputs - 
Integrated analog outputs - 
Communication functions  
PG/OP channel  
Global data communication  
Number of GD circuits, max. 4  
Size of GD packets, max. 22 Byte 
S7 basic communication  
S7 basic communication, user data per job 76 Byte 
S7 communication  
S7 communication as server  
S7 communication as client - 
S7 communication, user data per job 160 Byte 
Number of connections, max. 16  
Functionality Sub-D interfaces  
Type MP²I 
Type of interface RS485 
Connector Sub-D, 9-pin, female 
Electrically isolated - 
MPI  
MP²I (MPI/RS232)  
DP master - 
DP slave - 
Point-to-point interface - 
  
Type DP 
Type of interface RS485 
Connector Sub-D, 9-pin, female 
Electrically isolated  
MPI - 
MP²I (MPI/RS232) - 
DP master - 
DP slave yes 
Point-to-point interface - 
Functionality MPI  
Number of connections, max. 16  
PG/OP channel  
Routing - 
Global data communication  
S7 basic communication  
S7 communication  
S7 communication as server  
S7 communication as client - 
Transmission speed, min. 19.2 kbit/s 
Transmission speed, max. 187.5 kbit/s 
Functionality PROFIBUS slave  
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PG/OP channel - 
Routing - 
S7 communication - 
S7 communication as server - 
S7 communication as client - 
Direct data exchange (slave-to-slave 
communication) 

- 

DPV1 - 
Transmission speed, min. 9.6 kbit/s 
Transmission speed, max. 12 Mbit/s 
Automatic detection of transmission speed  
Transfer memory inputs, max. 64 Byte 
Transfer memory outputs, max. 64 Byte 
Address areas, max. - 
User data per address area, max. - 
Mechanical data  
Housing / Protection type  
Material die-cast aluminum 
Mounting via integrated pivoted lever 
Protect type front side IP 65 
Protect type back side IP 20 
Dimensions  
Front panel 187 x 90 x 6 mm 
Rear panel 154 x 77 x 55 mm 
Installation cut-out  
Width 156 mm 
Height 78 mm 
Minimum 2.5 mm 
Maximum front panel thickness 6 mm 
Weight 600 g 
Environmental conditions  
Operating temperature 0 °C to 60 °C 
Storage temperature -20 °C to 70 °C 
Certifications  
UL508 certification yes 
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Chapter 2 Deployment CC 03 - Operator panel 
 

This chapter explains the deployment and the project engineering of the 
operator panel of the CC 03. 
After the fast introduction there are information about the installation of the 
CC 03 and the configuration by the OP-Manager. This is followed by notes 
for commissioning. The chapter closes with a description of the operation 
of the panel. 
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Fast introduction 
 

For the installation in operating tables and control cabinet fronts a front 
panel cutting of 156mmx78mm (LxW) is needed. 
 

The project engineering for access to the internal CPU takes place in the 
configuration tool "OP-Manager" from VIPA that enables the online project 
engineering via MPI. 
 

Start the OP-Manager via click on . 
Open the dialog window for a new project via File > New. Enter a name 
and the according operating device and click on . For the first 

start, you should work with the standard project. Click on . 
The project window opens with the standard project that is already stored 
in the operator panel. 
Now you may change the values of the object groups "Screens", 
"Messages", "Tags" etc. by clicking on the according group and preset their 
objects in the object window. 
 

Within an object group you may create a new object via , alter it via 

 and delete it with . These functions are equal to the context 
functions Insert, Open res. Properties and Delete.  
 
This entry is automatically generated and is essential for communication 
between CC 03 and its CPU. Don't make any changes, please! 
 
With Tags you define all variables that refer to memory areas of the PLC 
and that have to be processed in the OP. 

To create a new variable, click on . Enter a name for the variable and a 
corresponding memory area of the internal CPU.  
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The display of a message happens event triggered. As soon as an event 
occurs in the specified CPU, the according message is monitored sorted 

after priority that can be acknowledged with .  The definition of the 
events happens under "Area Pointer" on project level. Here you assign a 
memory res. bit memory area of your PLC. The object groups "Messages" 
allow you to enter the according messages. 
 

Click on the object group "Screens" and create a new screen with . 
Screens consist of entries. Every screen can contain up to 20 entries. 
Always one entry is monitored per display page in a 2x20 character mask 
where you can branch if needed. You may enter the following elements in 
an entry: 
• Alpha numeric texts (no umlaut) 

• Variables for in- res. output via  as:  
- Tag: Variable that is linked to a value in the PLC with settable in- res. 

output format. You may also output plain text from a list that 
concerns to a PLC value. The list for the text assignment is 
stored in the object group "Text/Graphics Lists". 

- Date, Time: internal date and time-of-day 

• Soft key  that allows to execute programmed functions 
like e.g. a jump in a special entry. 

 

After you have finished the presetting, you save your project with , 

compile it with  and start it with an emulator with . The emulator 
creates an OP 03 on your PC and gives you the opportunity to test your 
programming without additional hardware. The usage of OP 03 is as the 
same as the usage of the CC 03. 

 brings you to the screen defined as start screen. The lower part of the 
emulator allows you to simulate events via PLC 1 that are later coming 
from the internal CPU. Please take care that the according events are 
programmed in your project engineering under "Area Pointers". 
You may also use the menu option "Switch to Green Cable Mode" to 
directly connect your PC with the CPU of the CC 03 via Green Cable and 
test your programming on the emulator. 
 

Note! 
The online project engineering requires a licensed version of the OP-
Manager! More information may be found at the online help of the OP-
Manager.  
 

Messages 

Create screen 

Compile and 
emulate 
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For commissioning and project engineering the CC 03 is to be externally 
power supplied by DC 24V and connected to the PC. For connection there 
are the following possibilities: 
• Transfer online 
• Transfer by MMC 
 
Note! 
The CC 03 is always to be externally power supplied by DC 24V. 
 

Here the transfer is executed via an exclusively directly connected Green 
Cable from VIPA and external power supply. 
 

Green Cable (VIPA 950-0KB00)
RS232

DC 24V

MPI

CC 03
CC 03

SHIFT

ESC

ENTER

4321
F1 F2 F3 F4

Commander Compact

9876

5
F5

0

,
+/-

MP2I

OP-Manager

 
 
Attention! 
• The Green Cable may exclusively deployed directly at the concerning 

jacks of the VIPA components (in between plugs are not permitted). 
• The lengthening of the Green Cable with another Green Cable res. The 

combination with further MPI cables is not permitted and causes 
damages of the connected components! The Green Cable may only be 
lengthened with a 1:1 cable (all 9 Pins are connected 1:1). 

 
With this transfer method the connection happens by means of a MPI 
adapter cable. The MPI converter cables are available from VIPA in 
different versions. At the PC side the MPI converter cable may be 
connected to the RS232 interface or the USB slot depending on the 
version. 
 

DC 24V
OP-Manager

MPI adapter

MPI

CC 03
CC 03

SHIFT

ESC

ENTER

4321
F1 F2 F3 F4

Commander Compact

9876

5
F5

0

,
+/-

MP2I

 
 
If the standard project is in the CC 03, you may set the OP mode "Operat. 

mode Transfer" via System > OP-Mode >  + , entering the 

password 100 and confirm with . Now the CC 03 awaits data with 
"Ready for Transfer". 

Commissioning 

     

Transfer online by 
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Load the OP-Manager with your project on your PC. You may only access 
the CC 03 online, if you work with a licensed version. 

Call the transfer function with a click on . 
Select MPI and set the transfer parameters like COM port, baud rate 38400 

via  and confirm your entry. 

With  configuration is confirmed and the transfer is started.  
 
 
With a licensed version of the OP-Manager there is the possibility to store 
your project as a MMC file. The file may be transferred to a MMC and read 
from MMC by the CC 03. 
 
• Load your project in the OP-Manager on your PC and compile the 

project. 
• Only a licensed version allows you to save your project as cfg-file using 

File > Save Blocks as > MMC-File. 
• Copy this file to your MMC and rename it to vp3.cfg. 
• Insert the MMC into the MMC slot of the CC 03. 

• Push the key combination + + , switch on the CC 03 and keep 
pushing the keys until the CC 03 branches to the "Setup-Menu". 

• Choose "Perform Load Prog from MMC" by using  and push . 
The CC 03 announces "Storing configuration" and shows a reboot with 
"Restarting". 
At wrong file name, the message "No program file found" occurs. With 
no plugged MMC, you receive the message "No MMC found". 

• Now the MMC may be removed 
 
After project transfer the CC 03 starts with the new project.  
As soon as the power supply of the CC 03 is switched on it starts 
automatically with the project. 
 

DC 24V
OP-Manager CC 03

CC 03

SHIFT

ESC

ENTER

4321
F1 F2 F3 F4

Commander Compact

9876

5
F5

0

,
+/-

MP2I

 
 
These steps of the fast introduction are more described at the following 
pages. 
 
 
 

Start transfer at  
OP-Manager 

Transfer by MMC 

Operation 
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Installation 
 

The CC 03 is suitable for the installation in operating tables and control 
cabinet fronts. The installation happens via the back side. The CC 03 is 
provided with a patented integrated fixing technique that allows an easy 
connection with a simple screwdriver. 
 

Note! 
Please also regard the "General installation guidelines" in this manual. 
 

For the installation in operating tables and control cabinet fronts, you need 
the following front panel cutting: 
 

156mm

78
m

m

 
 

The fixing technique is integrated in the casing of the CC 03 and 
accessible via the back side. 
For the installation, a small slit screwdriver is required. Push the operator 
panel [3] from the front side into the front panel cutting [1] until it touches 
the panel with the seal [2]. Now bolt the lever [5] clockwise with the 
screwdriver [4] until it rotates to the outside. Further screwing bolts the 
lever to the front panel until it holds the CC 03 to the control cabinet front.  
 

1

2 3

4

5

 

Overview  

     

Installation cutting 

Installation 
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Cabling 
 

Connecting external  
power supply 
 
1

2

3

 

For external DC 24V power supply there is a connector at the back
side of the CC 03.  
The wiring takes place with spring clamp technology. The cabling 
with spring clamp technique enables a fast and easy connection of
your supply wires. In opposite to a screw connection, this
connection is vibration secure. You may connect cables with a
cross-section of 0.08 mm2 to 2.5 mm2. You may use flexible cores 
without end case as well as stiff wires. 
The wires are fixed at the spring clamp contacts as follows: 
 

DC24V

L+  

+

M  M for screwdriver

for wires  
 

The illustration on the left side shows the steps of the cabling seen 
from top. 
• To conduct a wire you plug a fitting screwdriver obliquely into the

rectangular opening like shown in the picture. 
• To open the contact spring you have to push the screwdriver in

the opposite direction and hold it. 
• Insert the de-isolated wire into the round opening. You may use

wires with a cross-section from 0.08mm2 to 2.5mm2. 
• By removing the screwdriver the wire is connected safely with the

plug connector via a spring.  
 
 
 

Connecting  
I/O periphery  
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The in-/output periphery has one 10pin plug connector per module
(1 column). This plug connects the signal and supply lines of the in
res. outputs. For the wiring connection plugs with spring clamp 
technique are also used. 
The pin assignment of the I/O periphery is to be found in the
description of the modules. 
You may connect cores with a diameter of 0.08mm2 to 2.5mm2 (up 
to 1.5mm2 with 18pin). 
The following illustration shows a module with a 10pin plug. 
 
The spring clip will be destroyed when inserting a screw driver
into the core opening! 
Insert the screw driver exclusively into the rectangle openings
of the plug! 
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Project engineering operator panel 
 

For the project engineering of the CC 03 operator panel surface you may 
use the OP-Manager from VIPA or ProTool from Siemens. 
For both tools are similar in structure and operation, the project 
engineering is illustrated in the OP-Manager from VIPA. 
The OP-Manager runs with Windows 2000 and XP. The OP-Manager 
offers you a fully graphical user interface that allows you a comfortable 
project engineering in 3 different languages.  
You transfer your project engineering into your operator device via MPI. 
 

In opposite to ProTool, the OP-Manager has an integrated emulator that 
simulates an operation panel on your PC. You can test your project 
engineering without additional hardware. You may also use the COM 
interface to connect a CPU via MPI that can be accessed by the emulator. 
The area pointers are to find in the OP-Manager in the register "Area 
Pointer". 
 

 
 

The languages that are available in your project are set in the register 
"Language Assignment". 
 

The following table lists the terms that are used for the project engineering 
in the OP-Manager. 
 

Meaning Term  Meaning Term 
Pictures Screens  PLC Controllers 
Messages Messages  Symbolic lists Text/Graphic Lists 
Variables Tags  Area Pointer Area Pointer 

 

Overview 

Differences to 
ProTool 

Glossary 
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Start the OP-Manager by clicking on . 
Open the dialog window for a new project via File > New. Enter a name 
and the according operating device and click on . For the first 
start, you should work with the standard project. Click on . 
The project window opens with the standard project that is already stored 
in the CC. 
You may alter the name for your project or add a description via File > 
Project Information at any time. 
 

2

6

3

4 5

1

7 
 
The project window contains the following important elements: 
[1] Symbol bar with the most important functions. Here you also set the 

language that is to be altered. 
[2] This area shows your project with the concerning object groups in a 

tree structure. 
[3] Here you see the objects of an object group. 
[4] As soon as you choose your project as object group, among others, 

the register "Area Pointer" is available. Under "Area Pointer" you may 
assign certain events in your CPU to a state in your CC like e.g. open 
a screen or throw one of the messages that you can define under 
"Messages". 

[5] As soon as you choose your project as object group, among others, 
the register "Language Assignment" is available. Here up to 3 
languages may be set which languages are available in your project.  

[6] Here are the status messages that are creates at a compiler run res. 
Download. 

[7] OP-Manager information window. Information about the entry mode 
(OVR=Overwrite), the chosen language and the type of the operating 
panel. 

   

Create project 
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Within an object group you may create a new project via  in the symbol 

bar, alter it with  and delete it with . These functions are equal to 
the context functions Insert, Open res. Properties and Delete. 
 

The following objects are available: 
• Controllers (CPU and MPI communication parameter) 
• Tags (Variables referring to PLC areas) 
• Messages (messages that can be thrown event triggered) 
• Screens (output areas on the operator panel) 
• Text/Graphic Lists (Plain text assignment for tags) 
 

When you create a new project, a controller is automatically created too. At 
deployment of the CC 03 here must be exactly 1 controller entry because 
you only have access to the integrated CPU. Please do not change these 
settings! 
 
Under "Tags" you define all variables that refer to memory areas of your 
PLC and have to be processed by the CC. 

Click on  to create a new variable. Enter a name for the new tag and a 
corresponding memory area of your CPU. 
  

 
 

Via the register "Limit Value" you may define areas for input variables. 
When you enter a value exceeding this range, the input is rejected. 
Some variable types can be configured via the register "Functions". 
"Options" allows you to enter a comment to the variables. 
 
 

Insert objects 

Object overview 

Controllers (CPUs) 

Tags (Variables) 
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The output of a message happens event triggered. As soon as an event 
occurs in the specified CPU, the according messages are shown sorted by 
priority. 
Please regard that you first have to define the initializing event in the 
project object group, register "Area Pointer", if you want a message 
because of a CPU event.  
For this, create a new object with the type "Event Messages" via the 

register "Area Pointer" with  and assign a DB or bit memory area. For 
the output follows the bit pattern of the defined area, several messages can 
be displayed simultaneously. The output is sorted after priority starting with 

priority 1. Every message must be acknowledged with . 
 
 
"Screens" allows you to monitor an image of the process. You may display 
processes and preset process values.  
The screen object contains several screen entries. One screen entry has 
display size (2x20 characters) and is marked with an entry number. With 
the object name and the entry number you may directly access a screen 
entry. 
You may place the following elements into a screen object: 
• Alpha numeric texts 

• Variables for in- res. output via  as:  
- Tag: Variable that is linked to a value in the PLC with settable in- res. 

output format. You may also output plain text from a list that 
concerns to a PLC value. The list for the text assignment is 
stored in the object group "Text/Graphics Lists". 

- Date: internal date  
- Time: internal time-of-day 
The format of date respectively time of day and the flashing of the input 

fields may be set by  . 

• Soft key  that allows to execute programmed functions 
like e.g. a jump in a special entry. 

 
 

Messages  

Screens  
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Click on the object group Screens and create a new screen with . Click 
on the 1. screen entry and insert the wanted elements. This screen is 
automatically the start screen. You can assign the "start screen" property 
to another screen via the object properties. 
You may also alter the language during the project engineering. This only 
influences the monitored text. 
 

 
 
Every screen entry has a soft key bar in the lower part of the window. Here 
you can assign a function to one of the function keys (1...5). Click on the 
according function key and assign a function via  like e.g. jump 
into screen entry. 
The access to the soft keys may be configured with or without additional  

 key. This may be set with . 
 
 

Screens (Continue) 

Function keys  
(Soft keys) 
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To prevent unauthorized operating, the CC 03 has an integrated password 
protection that enables passwords for up to 8 levels. Access to all 
password levels (Level 9) is only allowed with the "Supervisor-Password" 
that is defined in your project. 
The assignment of the according password level happens in the OP-
Manager. Here you can assign password levels from 1 to 9 according to 
the raising importance of the functions assigned to the soft keys. Setting 
Level 0 deactivates the password request.  
You may set the passwords for the levels 1 to 8 only at the CC 03. You 
need access to the screen "Password" in your project (see standard 
project). 
For access to this screen, the "Supervisor-Password" is required.  
 
The Supervisor-Password allows full access to all functions of the CC 03. 
The Supervisor-Password is transferred to the CC 03 together with the 

project. To enter the Supervisor-Password, choose  in your project. 
The following dialog window appears: 
 

 

Under "Supervisor" you type a password 
and set via "Logout Time" the time for 
which the password is valid after login. 
 

 
You may set a password level for every soft key definition like shown in the 
picture.  
 

 

Please regard that the password levels 
for integrated standard screens of the CC 
03 are preset e.g.: 
Level 9: Password Edit, OP-Mode     
Level 8: ForceVAR     
Level 6: System>MPI-Addr 
Level 4: System>Dat/Time 
Level 2: System>Language 
Level 0: StatVAR, Password>Logout 
 

 
 

Password 
protection for 
soft keys 

Set Supervisor-
Password 

Set password  
level 
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This object allows you to assign a text to a numeric value, which you can 
refer to via a tag (variable). 

Mark the object group "Text/Graphics Lists" and add a new object with 
 assigns a text to a numeric value. 

 

 
 
The reference to a tag is set in the screen object. Insert a field within a 

screen entry with , select the property "Text" at "Display As", choose 
the according tag and your list object at "Text List". 
 
 
Note! 
Please regard that the output is restricted to texts that are assigned to a 
numeric value. Values without text assignment are displayed as "∗∗∗∗∗ ". 
  

In delivery state, the CC has integrated standard screens that are 
described in the following: 
 
Screen name Usage 
Change modes Switch between Online-, Offline- and Transfer operation 
Language Language selection 
Edit password Here you may set the passwords for the different levels 

(Default: 100) and login via a password. 
Time/Date Date and time input 
MPI address Input of MPI address and baud rate 

Text/Graphics Lists 

     

Integrated screens 
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The OP-Manager provides you with an OP emulator that emulates an  
OP 03 on your Windows system. The usage of OP 03 is as the same as 
the usage of the CC 03. This allows you to test your project engineering 
without further hardware needs. 
To start the emulator, you first have to save your project and compile it with 

. After the compilation you may start the emulator with . After every 
change of the program, you have to recompile it again. The emulator has 
the following structure: 
 

 
 
The upper half shows an original OP 03 with line display and keyboard. 
The lower half allows you to simulate an event on the internal CPU. Here 
you may jump to special screen entries by presetting the according values 
res. cause messages.  
You may also use the menu option "Switch to Green Cable Mode" to 
directly connect your PC with the CC-CPU via Green Cable and test your 
programming on the emulator. 
When your programming runs error-free on the emulator, you may transfer 
your project via MPI into your CC 03. 
 

Note! 
Please regard that the CPU emulation only works when you've created 
objects of the type "Screen Number" and "Event Messages" in your project 
group in the register "Area Pointer". 
 
 
 
 

Emulate project 
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Commissioning 
 

• A project has been configured by the OP-Manager and is ready for 
download. 

• The CC 03 is powered by DC 24V. 
 
For project transfer there are the following possibilities: 
• Transfer online 
• Transfer by MMC 
The online project engineering requires a licensed version of the OP-
Manager! More information may be found at the online help of the OP-
Manager.  
In the following the commissioning is described concerning these variants. 
 
Note! 
The CC 03 is always to be externally power supplied by DC 24V. 
 

For online transfer the CC 03 is to be connected to the PC via the MPI 
interface. Here the VIPA Green Cable or a MPI adapter cable may be 
used. 
 
The Green Cable is available from VIPA and has the order number VIPA 
950-0KB00. Connect as shown the RS232 interface of your PC and the 
MPI interface of the CC 03 by VIPA Green Cable. 
 

Green Cable (VIPA 950-0KB00)
RS232

DC 24V

MPI

CC 03
CC 03

SHIFT

ESC

ENTER

4321
F1 F2 F3 F4

Commander Compact

9876

5
F5

0

,
+/-

MP2I

OP-Manager

 
 
Attention! 
• The Green Cable may exclusively deployed directly at the concerning 

MP2I jacks of the VIPA components (in between plugs are not 
permitted). 

• The lengthening of the Green Cable with another Green Cable res. The 
combination with further MPI cables is not permitted and causes 
damages of the connected components! The Green Cable may only be 
lengthened with a 1:1 cable (all 9 Pins are connected 1:1). 

 

Preconditions 

Project transfer 

     

Transfer online 

Online connection 
by Green Cable 
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With this transfer method the connection happens by a MPI adapter cable. 
The MPI converter cables are available from VIPA in different versions. At 
the PC side the MPI converter cable may be connected to the RS232 
interface or the USB slot depending on the version. 
 
 

DC 24V
OP-Manager

MPI adapter

MPI

CC 03
CC 03

SHIFT

ESC

ENTER

4321
F1 F2 F3 F4

Commander Compact

9876

5
F5

0

,

+/-

MP2I

 
 
 
If the standard project is in the CC 03, you may set the OP mode "Operat. 

mode Transfer" via System > OP-Mode >  + , entering the 

password 100 and confirm with . 
Now the CC 03 awaits data with "Ready for Transfer".  
If the standard project is not yet present the setup menu may be connected 
with the following proceeding: 

Push the key combination + + on the CC 03 and turn it on again. 
Hold the keys until the CC 03 branches to the "Setup menu". Choose with 

 "Perform Download from PC" and push .   
The CC 03 now awaits data with "Ready for Transfer".  

This operation may always be aborted by . 
 
 
Load the OP-Manager with your project on your PC. You may only access 
the CC 03 online, if you work with a licensed version. 

Call the transfer function with a click on . 
Select MPI and set the transfer parameters like COM port, baud rate 38400 

via  and confirm your entry. 

With  configuration is confirmed and the transfer is started. 
 
 

Online connection 
by MPI adapter 
cable 

Prepare CC 03 for 
data transfer 

Start transfer at  
OP-Manager 
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With a licensed version of the OP-Manager there is the possibility to store 
your project as a MMC file. The file may be transferred to a MMC and read  
from MMC by the CC 03. 
 
• Load your project in the OP-Manager on your PC and compile the 

project. 
• Only a licensed version allows you to save your project as cfg-file using 

File > Save Blocks as > MMC-File. 
• Copy this file to your MMC and rename it to vp3.cfg. 
• Insert the MMC into the MMC slot of the CC 03. 

• Push the key combination + + , switch on the CC 03 and keep 
pushing the keys until the CC 03 branches to the "Setup-Menu". 

• Choose "Perform Load Prog from MMC" by using  and push . 
The CC 03 announces "Storing configuration" and shows a reboot with 
"Restarting". 
At wrong file name, the message "No program file found" occurs. With 
no plugged MMC, you receive the message "No MMC found". 

• Now the MMC may be removed 
 

After project transfer the CC 03 starts with the new project.  
As soon as the power supply of the CC 03 is switched on it starts 
automatically with the project. 
 

DC 24V
OP-Manager CC 03

CC 03

SHIFT

ESC

ENTER

4321
F1 F2 F3 F4

Commander Compact

9876

5
F5

0

,
+/-

MP2I

 
 
In delivery state or after an overall reset the CC 03 starts with the standard 
project of the OP-Manager. 
 
 
 

Transfer by MMC 

Operation 

Startup in  
delivery state 
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Deployment operator panel 
 

The CC 03 starts as soon as it is powered by DC 24V. 
 

In delivery state, the CC 03 has a standard project where all functions 
required for the operation are integrated. 

You reach the menu res. the pictures of a loaded project by using  after 
start-up.  
For the navigation the following keys are available: 

 res.  Navigation to previous res. next picture 

 res.  Navigation to previous res. next picture 

Push additionally  to navigate horizontal within a picture with  res. 

 and use  res.  to select for example at hexadecimal entry the 
according sign from the character set that you may not enter via the 
keyboard. 

With  you leave and accept the date entry. 

With  you abort an entry res. you come back to the next superordinated 
menu level.  

The keys  ...  can be programmed in your project engineering tool 
as soft keys and may store picture related functions.  
The access to the soft keys can be programmed with or without additional 

 key. This can be set via  in the OP-Manager from VIPA res. 
ProTool from Siemens. 

 allows you to change the numeric sign res. with  +  to set a 
comma. 
 
 

Switch on 

Operation via 
keyboard 
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Push the key combination + +  simultaneously before switching 
on the device to reach the SETUP where basic functions are at your 
disposal. Please keep pushing the keys until "Entering Setup ___" is 
monitored in the display.  
 

The setting of the display contrast is limited to the SETUP by using  + 

 res. . 
 

The navigation happens with  res. , the selection with .  
leaves the SETUP again. 
 
The SETUP provides the following functions:  
• Setup default prog 

This function overwrites the current configuration with the basic 
configuration. 

• Download from PC 

This function prepares the CC to receive configuration data from the 
OP-Manager via MPI. 
In delivery state the CC has the MPI address 2. 

To control the MPI address you may leave the SETUP with 2x  and 

call the MPI address and the baud rate via  SYSTEM  >>  

MPI-ADR . These values may only be changed via a hardware 
configuration. To return to the SETUP you have to shut down the CC 
and turn it on again pushing the according key combination. 

Select Download from PC and push  
After the end of the data transfer the data is checked and stored in the 
memory. If everything is OK, the CC starts with the new configuration. 

• Display error log 

This causes an output of all error codes stored in the CC. 
• Load from MMC  

This function allows you to transfer your configuration from a plugged 
MMC. 

 
 
 
 
 
 
 

SETUP for data 
transfer, error 
diagnosis and  
contrast setting 

Set display contrast  

Navigation 

Data transfer and 
error diagnosis 
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Chapter 3 Deployment CC 03 - CC-CPU 
 

This chapter includes all information required for the deployment of the CC-
CPU, from the project engineering and addressing up to firmware update 
and commissioning. 
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Start-up behavior 
 

After power supply is turned on, the CC-CPU switches to the operating 
mode that has been selected at the operating mode switch and the 
operating panel starts with the recent project res. with the standard project. 
Now you may transfer your PLC project from your CPU projecting tool into 
the CC-CPU via MPI res. plug in a MMC containing your PLC project 
(s7prog.wld) and request an overall reset. For the project engineering of 
the operator panel you may load an OP manager project online via MPI 
res. load it from MMC as vp3.cfg. 
 

The following picture shows the approach: 
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Note! 
The transfer of the user application from the MMC into the battery buffered 
RAM respectively Flash memory of the CC-CPU takes always place after 
an overall reset or PowerON! 
 

When the CC-CPU is delivered it has been reset. 
After a STOP→RUN transition the CC-CPU switches to RUN without 
program. If no project is loaded the operator panel starts with the standard 
project of the OP manager. 
 

The accu is loaded directly via the integrated power supply by means of a 
load electronic and guarantees a buffer of ca. 30 days. If this time is 
exceeded, the accu may be totally discharged and the battery buffered 
RAM is erased. 
Now the CC-CPU executes an overall reset and switches to STOP. This 
process is stored in the diagnostic buffer with the entry: "Start overall reset 
automatically (unbuffered POWER-ON)".  
If a MMC is plugged in, the program on the MMC is transferred into the 
RAM. Otherwise the CC-CPU uses the program in the internal flash and 
transfers it to the RAM. With empty battery the operator panel 
automatically loads the standard project. 
 

Turn on  
power supply 

Overall reset 

     

Default boot 
procedure, as 
delivered 

Start-up with 
empty accu 
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Principles of the address allocation 
 

To provide specific addressing of the installed peripheral modules, certain 
addresses must be allocated in the CC-CPU. 
At the start-up of the CC-CPU, the CPU automatically assigns the addresses 
of the I/O periphery starting at 0. 
 

The signal states of the lower addresses (0 ... 127) are saved in a special 
memory area called the process image.  
The process image is divided into two parts: 
• process image of the inputs (PII) 
• process image of the outputs (PIQ) 
 

Peripheral area
0
.
.
.

127

128
.
.
.

1023

Process image
0
.
.
.

127

0
.
.
.

127

Inputs
PII

Outputs
PIQ

Digital module

Analog module

 
 
After every cycle the process image is updated. 
 

You may access the modules with read res. write accesses to the 
peripheral bytes or the process image. 
To define addresses a hardware configuration may be used. For this, click 
on the properties of the according module and set the wanted address. 
 

If you do not like to use a hardware configuration, an automatic addressing 
comes into force. First the internal I/O periphery is allocated by 3 bytes, 
each starting at 0, then the I/O periphery connected by bus extension are 
addressed. 
 

Note! 
Please regard that a read and write access to the same address different 
modules may be accessed. 
The addressing ranges of digital and analog modules are different when 
they are addressed automatically. 
Digital modules:   0 ... 127 
Analog modules: 128 ... 1023 

Overview 

Signal states in 
the process image 

Define addresses 
by hardware 
configuration 

Automatic 
addressing 
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CC-CPU - Project engineering 
 

The project engineering and the address allocation take place in the 
Siemens SIMATIC manager as a virtual PROFIBUS system. For the 
PROFIBUS interface is standardized also software sided, the functionality 
is guaranteed by including a GSD-file into the Siemens SIMATIC manager. 
Transfer your project into the CC-CPU via a serial connection to the MPI 
interface. 
 

For the project engineering of your Micro-PLC the following requirements 
have to be fulfilled: 
• Siemens SIMATIC manager is installed on PC res. PG. 
• The GSD-file is included to the hardware configurator from Siemens.  
• serial connection to the CC-CPU  (e.g. "Green Cable" from VIPA).  
 

Note! 
The configuration of the CC-CPU requires a thorough knowledge of the 
Siemens SIMATIC manager and the hardware configurator from Siemens! 
 

The hardware configurator is a component of the Siemens SIMATIC 
manager. It serves the project engineering. A list of modules that can be 
configured by this tool can be obtained from the hardware catalog. 
For the deployment of the CC 03 the inclusion of GSD file from VIPA in the 
hardware catalog is required. You will find the CC 03 under the according 
order no. 603... in the GSD VIPA_11x.GSD for the System 100V. 
 

• Copy the VIPA GSD-file into VIPA_11x.GSD your GSD directory  
... \siemens\step7\s7data\gsd. 

• Start the Siemens hardware configurator. 
• Close all projects. 
• Go to Options > Install New GSD. 
• Enter VIPA_11x.GSD. 
• Refresh the hardware catalog via   

Options > update catalog. 
Now the modules of the VIPA System 100V and the CC 03 variants from 
VIPA have been integrated into the hardware catalog and are available for 
configuration. Here you may also find the extension modules that may be 
connected via the system bus expansion. 
 

General 

Preconditions 

     

Installation of the 
Siemens hardware 
configurator  

Including the  
GSD file 
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To be compatible with the hardware configurator from Siemens, you have 
to configure the CC 03 as a virtual PROFIBUS system following these 
steps: 
 
• Create a new project System 300. 
• Include a profile rail from the hardware catalog. 
• You find the PLC with PROFIBUS master in the hardware catalog 

under:  
Simatic300/CPU-300/CPU315-2DP/6ES7 315-2AF03-0AB0. 

• Add the CPU 315-2DP (6ES7 315-2AF03-0AB0). 
• Assign a PROFIBUS address for your master (except 1). 
• Click on DP and choose the operating mode "DP master" in the object 

properties and confirm with OK. 
• Via a click on "DP" with the right mouse button, the context menu opens. 

Choose "Insert master system". Create a new PROFIBUS subnet via 
NEW. 

• Attach the system "VIPA_CPU11x" to the subnet. The respective entries 
are located in the hardware catalog under PROFIBUS DP > Additional 
Field Devices > IO > VIPA_System_100V. Assign the PROFIBUS 
address 1 to this slave (VIPA_11x.GSD required). PROFIBUS address 
1 is mandatory! 

• Place your CC 03 in the configurator at slot 0 by dragging and dropping 
it at the according no. 603... from the hardware catalog to the slot 0. 
Slot 0 is mandatory! 

 

 
The address areas of the in-/output periphery and the slots of the 
system bus extension are created and may be changed at any time.  

• Now you may include modules that may be connected via the system 
bus extension into the CC 03 via slot 1...4. For this, select the according 
module in the hardware catalog and place it to the according slot. 

• Save your project. 

Steps of project 
engineering 
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The CC-CPU has different parameters, that you may parameterize in the 
hardware configurator from Siemens via the concerning CPU-"properties". 
• The adjustments, concerning the CC-CPU are to be found in the 

properties of the CPU 315-2 DP. 
• Adjustments concerning the I/O periphery are to find under the 

"Properties" of the CC 03 like e.g. 603-2CC21. 
The parameterization is to be described here. 
 

Via double click on the CPU 315-2 DP, the parameterization window of 
your CC-CPU may be reached. 
Via the registers you have access to all parameters of the CC-CPU. 
 

 
 
The CC-CPU doesn't evaluate all parameters that you may parameterize in 
your projecting tool. The following parameters are evaluated by the CC-
CPU at this time: 
General : 
 MPI address of the PLC 
 baudrate (19.2kBaud, 187kBaud) 
  maximum MPI address  
Start-up: 
 Start-up at scheduled 

configuration not equal...  
 Ready message from module 
 Transfer of parameters to... 
Remanence : 
 No. of bit memory bytes from MB0 
 Number of S7-Timer from T0   
 Number of S7-Counter from Z0 
Protection: 
 Protection level via password ... 

Time alarm : 
 OB10 :  Execution 
  Active 
  Start date 
  Time-of-day 
Prompter alarm : 
 OB35 :  Execution 
Cycle / pulse marker: 
 Cycle watching time 
 Cycle load due to communication 
 OB85 call at periphery access 

error 
   Timing flags with marker byte no. 

Parameter 
setting 

CPU parameter 

Supported 
parameters 
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For the parameterization of the in-/output components of the CC 03 double 
click at slot 0 of the CC 03. 
 

 
 
Now you may alter the address assignment of integrated in-/output 
components via "Address/ID" like e.g. for the 603-1CC21.  
 

The register "Parameter" allows you to enter, for example for the CC 03 
with integrated PROFIBUS-DP slave 603-2CC21, parameters for the 
PROFIBUS connection. 
The PROFIBUS section maps its data area into the memory area of the 
CC-CPU. The assignment of the areas may be done in the register 
"Parameter". 
 

 
Input addr.: 

 
Address for receive data via PROFIBUS 

Input length: Length of the data area of the receive data 
Output addr.: Address for send data via PROFIBUS 
Output length: Length of the data area of the send data 
Prm Addr.: Address of the 24Byte parameter data of the 

master 
Diag Addr.: Address of the 5Byte user diagnosis data 
Stat Addr.: Address of the 2Byte status area 

 

PROFIBUS DP 
Addr.: 

PROFIBUS address of the DP slave 

 
More detailed information is to be found in the chapter "Deployment of the 
CC 03 under PROFIBUS". 
 
 

Parameter of the 
I/O components 

Parameter 
PROFIBUS 



Chapter 3   Deployment CC 03 - CC-CPU Manual VIPA HMI 

3-8  HB116E - CC 03 - Rev. 15/04 

There are 2 options for the transfer of your project into the CC-CPU: 
• Transfer via MPI  
• Transfer via MMC by means of a card reader 
 

The structure of a MPI network is in principal the same as the structure of a 
1.5MBaud PROFIBUS network. That means, the same rules are valid and 
you use for both networks the same components.  
Per default, the MPI network is working with 187.5kBaud. 
Every participant at the bus identifies itself with an unique MPI address. 
You connect the single participants via bus interface plugs and the 
PROFIBUS bus cable.  
 

A cable has to be terminated with its ripple resistor. For this you switch on 
the terminating resistor at the first and the last participant of a network or a 
segment. 
Please make sure that the participants with the activated terminating 
resistors are always provided with voltage during start-up and operation. 
 

• Connect your PG res. your PC via MPI with your CC-CPU. If your PG 
has no MPI functionality you may use the VIPA "Green Cable" for a 
point-to-point connection. The VIPA "Green Cable" has the order no. 
VIPA 950-0KB00 and may only be used with VIPA components! Please 
regard the hints for the deployment of the Green Cable in chapter 1. 

• Configure the MPI slot of your PC by monitoring them in the SIMATIC 
manager from Siemens under Options > Set PG/PC Interface. Set the 
parameters of your MPI network under "PC Adapter MPI" in the register 
MPI and enter your COM interface and the baud rate 38400 under 
"Local connection" (see following page). 

• Now choose the components you want to transfer and start the transfer 
to the CC-CPU with PLC > Upload Station. 

• For more security, install a MMC and transfer the application program to 
the MMC by clicking on PLC > Copy RAM to ROM.  
During the write operation the "MC"-LED at the back side of the CC 03 
is blinking. For internal reasons the message signalizing completion of 
the write operation arrives too soon. The write operation is only 
complete when the LED has been extinguished.  

 
 

Project transfer 

Transfer via MPI 

Terminating resistor 
 

Approach 
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Hints for the configuration of a MPI interface are to find in the 
documentation of your programming software.  
Here we only want to show the usage of the "Green Cable" from VIPA 
together with the programming tool from Siemens. 
The "Green Cable" establishes via MPI a serial connection between the 
COM-interface of the PC and the MP2I jack of the CC-CPU. 
 
 

Attention! 
Please regard, that you may use the "Green Cable" exclusively at the MP2I 
jacks of the Components from VIPA! 
 
 

• Start the SIMATIC manager from Siemens. 
• Choose Options > Set PG/PC Interface 

→ The following dialog window appears, where you may configure the 
according MPI slot: 

• Choose the "PC Adapter (MPI)" in the list, probably you may have to 
add it first and Click on . 
→ In the following 2 sub dialogs you may configure your PC adapter like 

shown in the picture. 
 

• In the Register "MPI", the 
default settings are  
recommended. Please regard 

that  has influence 
on the settings at "Local 
connection". 

 
 
 
• At "Local connection" you 

choose the COM port and set, 
for the communication via MP2I, 
the transfer rate at 38400bps. 

• Close both windows with 
 . 

 

To test the connection, plug the VIPA Green Cable to the COM interface of 
your PC and to the MP2I jack of your CC-CPU.  
Via PLC > Display Accessible Nodes you reach the CC-CPU with the 
preset MPI address 2. 
 

  

Configure MPI for 
Green Cable 

 

Test 
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As external storage medium a MMC is deployed. The MMC (Multi Media 
Card) serves as external transfer medium for programs and firmware for, 
among others, it provides the PC compatible FAT16 file system. With an 
overall reset or PowerON the MMC is automatically read. There may be 
stored several projects and sub-directories on a MMC storage module. 
Please consider that the current project is stored in the root directory and 
has one of the in the following described file names. 
 
Always after an overall reset and PowerON the CC-CPU tries to load a 
user program from the MMC into the battery-buffered RAM or in the Flash 
memory. Here the following file names may be assigned to the project 
depending upon the desired functionality: 
• S7PROG.WLD 

After overall reset the user program S7PROG.WLD is transferred into 
the battery-buffered RAM. 

• S7PROGF.WLD (starting with Firmware-Version V. 3.8.6) 
After overall reset the user program S7PROG.WLD is transferred into 
the battery-buffered RAM and additionally into the Flash memory. An 
access to the Flash memory takes only place at empty battery of the 
buffer and when no MMC with user program is plugged-in. 

• AUTOLOAD.WLD 
After PowerON the user program AUTOLOAD.WLD is transferred into 
the battery-buffered RAM. 

 
When the MMC has been plugged-in, the write command stores the 
content of the battery-buffered RAM as S7PROG.WLD at the MMC. The 
write command is controlled by means of the Siemens hardware 
configurator via PLC > Copy RAM to ROM. During the write process the 
"MC"-LED of the CC-CPU is blinking. When the LED expires the write 
process is finished. Simultaneously a write process into the internal Flash 
memory of the CC-CPU takes place.  
 
After a write process onto the MMC, an according ID event is written into 
the diagnostic buffer of the CC-CPU. To monitor the diagnostics entries, 
you select PLC > Module Information in the Siemens SIMATIC manager. 
Via the register "Diagnostic Buffer" you reach the diagnostics window.  
The following events may occur: 

Event-ID Meaning 
0xE100 MMC access error 
0xE101 MMC error file system 
0xE102 MMC error FAT 
0xE200 MMC writing finished 
0xE300 Internal Flash writing finished  

More information to the event IDs may be found at the end of this chapter.  
 
Note! 
If the size of the user application exceeds the user memory of the CC-
CPU, the content of the MMC is not transferred to the CC-CPU.  
Before the transfer execute a compression, for this does not automatically 
happen. 

Transfer via 
MMC 

Transfer  
MMC→→→→RAM→→→→ROM 

Transfer  
RAM→→→→MMC→→→→ROM 

Transfer control 
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CC-CPU - Operating modes  
 

The CC-CPU there are 3 operating modes: 
• Operating mode STOP 
• Operating mode START-UP 
• Operating mode RUN 
 
Certain conditions in the operating modes START-UP and RUN require a 
specific reaction from the system program. In this case the application 
interface is often provided by a call to an organization block that was 
included specifically for this event. 
 

• The application program is not processed. 
• If there has been a processing before, the values of counters, timers, 

marker and the process image are retained during the transition to the 
STOP mode. 

• Outputs are inhibited, i.e. all digital outputs are disabled. 
• RUN-LED  off 
• STOP-LED  on 
 

• During the transition from STOP to RUN a call is issued to the start-up 
organization block OB 100. The length of this OB is not limited. The 
processing time for this OB is not monitored. The start-up OB may issue 
calls to other blocks. 

• All digital outputs are disabled during the start-up, i.e. outputs are 
inhibited. 

• RUN-LED blinks 
• STOP-LED off 
When the CC-CPU has completed the start-up OB, it assumes the 
operating mode RUN. 
 

• The application program in OB 1 is processed in a cycle. Under the 
control of interrupts other program sections can be included in the cycle. 

• All timers and counters being started by the program are active and the 
process image is updated with every cycle. 

• The BASP-signal (outputs inhibited) is deactivated, i.e. all digital outputs 
are enabled. 

• RUN-LED on 
• STOP-LED off 
 
 
 

Overview 

Operating mode 
STOP 

Operating mode 
START-UP 

Operating mode 
RUN 
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CC-CPU - Overall reset 
 

During the overall reset the entire user memory (RAM) of the CC-CPU is 
erased. Data located in the memory card is not affected. 
You have 2 options to initiate an overall reset: 
• initiate the overall reset by means of the function selector switch 
• initiate the overall reset by means of the Siemens hardware configurator      
 
 
Note! 
You should always issue an overall reset to your CC-CPU before loading 
an application program into your CC-CPU to ensure that all blocks have 
been cleared from the CC-CPU. 
 

Condition 
The operating mode of the CC-CPU is STOP. Place the function selector 
on the CC-CPU in position "ST" → The S-LED is on. 
 
Overall reset 
• Place the function selector in the position MR and hold it in this position 

for app. 3 seconds. → The S-LED changes from blinking to permanently 
on. 

• Place the function selector in the position ST and switch it to MR and 
quickly back to ST within a period of less than 3 seconds.  
→ The S-LED blinks (overall reset procedure). 

• The overall reset has been completed when the S-LED is on 
permanently. → The S-LED is on. 

 
The following figure illustrates the above procedure: 
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Overview 
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At this point the CC-CPU attempts to reload the parameters and the 
program from the memory card. → The lower LED (MC) blinks. 
When the reload has been completed the LED is extinguished. The 
operating mode of the PLC will be STOP or RUN, depending on the 
position of the function selector. 
 

Condition 
The operating mode of the CC-CPU has to been stopped.  
You may place the CC-CPU in STOP mode by the menu command 
PLC > Operating mode. 
 
Overall reset 
You may request the overall reset by means of the menu command PLC > 
Clear/Reset. 
In the dialog window you may place your CC-CPU in STOP mode and start 
the overall reset if this has not been done as yet. 
The S-LED blinks during the overall reset procedure. 
When the S-LED is on permanently, the overall reset procedure has been 
completed. 
 

At this point the CC-CPU attempts to reload the parameters and the 
program from the memory card. → The "MC"-LED blinks. 
When the reload has been completed, the LED is extinguished. The 
operating mode of the PLC will be STOP or RUN, depending on the 
position of the function selector. 
 
 
 

Automatic reload 

Overall reset via 
hardware 
configurator from 
Siemens 

Automatic reload 
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Firmware update 
 

The CC 03 offers you the option to execute a firmware update via MMC 
using the reserved file name firmware.bin or the update software and the 
Green Cable from VIPA. 
The last recent firmware versions can be downloaded in the service area of 
www.vipa.de. 
 

Attention! 
Please be very careful with loading a new firmware. Under certain 
circumstances you may destroy your CC 03, for example if the voltage 
supply is interrupted during transfer or if the firmware file is defective. 
In this case, please call the VIPA hotline! 
Please also regard that the update version has to be different from the 
existing version, otherwise no update will happen. 
 

If you didn't execute a firmware update before, you may find the recent 
firmware version on the label on the backside of your CC 03. 
To download the firmware file, order no. and version no. (HW) are required. 
These ID numbers mark the storage directory of the concerning firmware. 
For example: The firmware file of a CC 03 with the order no. 603-2CC21 
and HW no. 1 is stored under the file name 603-2cc21_a1.xxx (xxx is the 
firmware version). 
 

• Go to www.vipa.de.  
• Click at  Service / Support > Downloads > Firmware and navigate via 

"HMI" to the firmware for your CC. 
• Extract the zip-file into the wanted directory on your PC. 
• If you want to execute the update with the Green Cable, the VIPA 

"Updater" is required that you may download under "Firmware" in the 
download area. Start the "Updater" with cpu_up.exe. 

Overview 

 

Read firmware 
version 

Proceeding 
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There may be several projects and directories on one MMC. Please regard 
that the recent firmware file for the CC 03 has to be stored in the root 
directory, i.e. on the most upper level. To enable the identification of this 
file as firmware, rename the file into firmware.bin. 
 
• Install your MMC reading device and plug in a MMC. Transfer the file 

firmware.bin to your MMC. 
• Set the RUN-STOP lever of the CC 03 in position STOP. 
• Turn off the power supply. 
• Plug the MMC with the firmware file into the CC-CPU. Please take care 

of the plug-in direction of the MMC. 
• Turn on the power supply. 
• After a short boot time, the alternate blinking of the LEDs SF and FC 

shows that a file has been found on the MMC. 
• Start the transfer of the firmware by tipping the RUN/STOP lever into 

position MRST within 10s. The PLC shows the transfer via a LED 
running light. 

• During the update process, the LEDs SF, FC and MC are blinking 
alternately. This process may last several minutes. 

• The update is ready and error free when all CC-CPU-LEDs are on. At 
fast blinking, an error has occurred. 

 

To update the firmware via Green Cable, the Green Cable from VIPA and 
the software tool "Updater" are required. The software can be downloaded 
from www.vipa.de. Load the Updater and extract the zip-file into a directory 
of your PC. 
Start the Updater with PLC_up.exe. The following dialog window appears: 

 
 
A more detailed description of the approach is on the following page. 

Transfer firmware 
from MMC  
into PLC 

Firmware update 
via Green Cable 
and "Updater"  



Chapter 3   Deployment CC 03 - CC-CPU Manual VIPA HMI 

3-16  HB116E - CC 03 - Rev. 15/04 

to 0. Connect the COM interface of the PC and the MP2I jack of your 
CC 03 via the Green Cable. 

to 1. Type the COM interface (you should not alter the setup). 
to 2. Turn off the CC, hold the RUN/STOP lever in position MRST and 

turn on the CC.  
Now the CC 03 is ready for the firmware update and monitors this 
by turning all LEDs on. 

to 3. Click on  in the Updater. 
to 4. A connection to the CC 03 is established and shown via the 

message [connected]. 
If an error message appears instead, repeat the steps above with 
another COM interface. 

to 5. At error free connection click on . 
Your CC 03 is now prepared for data transfer. 

to 6. A click on  opens a file selection window. Choose 
the according firmware and start the download with . 
If the error message "The selected file doesn't fit to your 
hardware" appears you may have been tried to download a 
firmware that is not compatible to your CC 03. With a valid 
firmware version, the update process starts. This process may last 
several minutes and is shown in a process bar.  
After the download, the following window should appear: 

to 7. Turn off the power supply of your CC 03, disconnect the Green 
Cable and turn on the power supply again. Now the CC 03 is 
ready with the new firmware. 

 
If your CC 03 does not start anymore, an error occurred during the 
firmware update. Please call the VIPA hotline. 
 
 
 

Continued 
firmware update 
via Green Cable 
and "Updater" 
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VIPA specific diagnostic entries 
 

You may read the diagnostic buffer of the CC-CPU via the Siemens 
manager. Besides of the standard entries in the diagnostic buffer, the VIPA 
CPUs support some additional specific entries in form of event-IDs. 
 

To monitor the diagnostic entries you choose the option PLC > Module 
Information in the Siemens SIMATIC manager. Via the register "Diagnostic 
Buffer" you reach the diagnostic window: 
 

 
 
The diagnosis is independent from the operating mode of the CC-CPU. 
You may store a max. of 100 diagnostic entries in the CC-CPU. 
The following page shows an overview of the VIPA specific Event-IDs. 
 
 

Entries in the 
diagnostic buffer 

Monitoring the 
diagnostic entries 
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Event-ID Description 
0xE003 Error at access to I/O devices  

Zinfo1: I/O address 
Zinfo2: Slot 

0xE004 Multiple parameterization of a I/O address  
Zinfo1: I/O address 
Zinfo2: Slot 

0xE005 Internal error – Please contact the VIPA-Hotline! 
0xE006 Internal error – Please contact the VIPA-Hotline! 
0xE007 Configured in-/output bytes do not fit into I/O area  
0xE008 Internal error – Please contact the VIPA-Hotline! 
0xE009 Error at access to standard back plane bus 
0xE010 Not defined module group at backplane bus recognized 

Zinfo2: Slot 
Zinfo3: Type ID 

0xE011 Master project engineering at Slave-CPU not possible or wrong slave configuration 
0xE012 Error at parameterization 
0xE013 Error at shift register access to VBUS digital modules 
0xE014 Error at Check_Sys 
0xE015 Error at access to the master 

Zinfo2: Slot of the master (32=page frame master) 
0xE016 Maximum block size at master transfer exceeded  

Zinfo1: I/O address  
Zinfo2: Slot 

0xE017 Error at access to integrated slave 
0xE018 Error at mapping of the master I/O devices 
0xE019 Error at standard back plane bus system recognition 
0xE01A Error at recognition of the operating mode (8 / 9 Bit) 
0xE0CC Communication error MPI / Serial 
0xE100 MMC access error 
0xE101 MMC error file system 
0xE102 MMC error FAT 
0xE104 MMC error at saving 
0xE200 MMC writing finished (Copy RAM to ROM) 
0xE210 MMC reading finished (reload after overall reset) 
0xE300 Internal Flash writing ready (Copy RAM to ROM) 
0xE310 Internal Flash reading ready (reload after battery failure)  

 
 

Overview of the 
Event-IDs 
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CC-CPU - Test functions 
 

For troubleshooting purposes and to display the status of certain variables 
you can access certain test functions via the menu item Debug of the 
Siemens SIMATIC manager. 
The status of the operands and the VKE can be displayed by means of the 
test function Debug > Monitor. 
You can modify and/or display the status of variables by means of the test 
function PLC > Monitor/Modify variables. 
 

This test function displays the current status and the VKE of the different 
operands while the program is being executed.   
It is also possible to enter corrections to the program. 
 

Note! 
When using the test function "Monitor" the PLC must be in RUN mode! 
 

The processing of statuses can be interrupted by means of jump 
commands or by timer and process interrupts. At the breakpoint the CC-
CPU stops collecting data for the status display and instead of the required 
data it only provides the PG with data containing the value 0. 
For this reason, jumps or time and process interrupts can result in the 
value displayed during program execution remaining at 0 for the items 
below: 
 
• the result of the logical operation RLO 
• Status / AKKU 1 
• AKKU 2 
• Condition byte 
• absolute memory address SAZ. In this case SAZ is followed by a "?". 
 
The interruption of the processing of statuses does not change the 
execution of the program. It only shows that the data displayed is no longer 
valid from that point on where the interrupt occurred. 

Overview 

Debug > Monitor 
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This test function returns the condition of a selected operand (inputs, 
outputs, flags, data word, counters or timers) at the end of program 
execution.   
This information is obtained from the process image of the selected 
operands. During the "processing check" or in operating mode STOP the 
periphery is read directly from the inputs. Otherwise only the process 
image of the selected operands is displayed. 
 
Control of outputs 
This function allows you to set the outputs to a wanted signal state. Here 
the command output lock for the outputs is released ignoring the user 
application. The process image is not altered. You may use this function to 
control the cabling and the correct operation of output modules. 
 
Attention! 
At direct access of outputs you must ensure safety for humans and 
machine. 
 
Control of variables 
The following variables may be modified: 
I, Q, M, T, C and D. 
The process image of binary and digital operands is modified 
independently of the operating mode of the CC-CPU.    
When the operating mode is RUN the program is executed with the 
modified process variable. When the program continues they may, 
however, be modified again without notification. 
Process variables are controlled asynchronously to the execution sequence 
of the program.  
 
 
 
 
 

PLC > 
Monitor/Modify 
variables 
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Chapter 4 Deployment CC 03DP with PROFIBUS DP 
 

Content of this chapter is the deployment of the CC 03DP with PROFIBUS. 
It includes all information required for deploying an intelligent PROFIBUS 
DP slave. 
 

 

Topic     Page 
Chapter 4 Deployment CC 03DP with PROFIBUS DP .................... 4-1 
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Principles 
 

PROFIBUS is an international open field bus standard for building, 
manufacturing and process automation. PROFIBUS defines the technical 
and functional properties of a serial field bus system that can be used to 
create a network of distributed digital field-automation equipment on the 
lower (sensor-/drive level) to middle performance level (process level).   
PROFIBUS comprises various compatible versions. The specifications 
contained in this description refer to PROFIBUS DP. 
 

PROFIBUS DP is particularly suitable for applications in production 
automation. DP is very fast, offers Plug'n'Play and is a cost-effective 
alternative to parallel cabling between PLC and the distributed periphery. 
PROFIBUS DP is conceived for high-speed data exchange on the sensor-
drive level. This is where central controllers like PLCs communicate via 
fast, serial connections with distributed in- and output devices.    
During a single bus cycle the master reads the input values from the 
various slaves and writes new output information into the slaves. 
 

PROFIBUS distinguishes between active stations (masters) and passive 
stations (slaves). 
Master equipment 
Master equipment controls the data traffic on the bus. There may be also 
several masters at one PROFIBUS. This is referred to as multi-master 
operation. The bus protocol establishes a logical token ring between the in-
telligent devices connected to the bus.  
A master can send unsolicited messages if it has the bus access 
permission (Token). In the PROFIBUS protocol these masters are also 
referred to as active stations.  
Slave equipment 
Typical slave equipment holds data of peripheral equipment, sensors, 
drives and transducers. The VIPA PROFIBUS couplers are modular slave 
devices, which transfer data between the periphery and the leading master.  
These devices do not have bus access permission in accordance with the 
PROFIBUS standard. They can only acknowledge messages or transfer 
messages to a master if requested by the respective master. Slaves 
occupy a very limited part of the bus protocol. Slaves are also referred to 
as passive stations. 
 
 

General 

PROFIBUS DP  

Master and Slaves 
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The bus communication protocol provides two procedures for accessing 
the bus:  
 
Communications with the master is also referred to as token passing 
procedure. Token passing guarantees that the station receives access 
permission to the bus. This access right to the bus is passed between the 
stations in form of a "token". A token is a specific message that is 
transferred via the bus.  
When a master is in the possession of the token it also has the access 
right to the bus and can communicate with all other active and passive 
stations. The token retention time is defined when the system is being 
configured. When the token retention time has expired the token is passed 
along to the next master that acquires the bus access rights with the token 
so that it can communicate with all other stations. 
 

Data is exchanged in a fixed repetitive sequence between the master and 
the slaves assigned to the respective master. When you configure the 
system you define which slaves are assigned to a certain master. You can 
also specify which DP slave is included in the cyclic exchange of 
application data and which ones are excluded. 
The master-slave data transfer is divided into parameterization, 
configuration and data transfer phases. Before a DP slave is included in 
the data transfer phase the master verifies during the parameterization and 
configuration phase, whether the specified configuration agrees with the 
effective configuration. This verification process checks the device type, 
format and length as well as the number of inputs and outputs. This 
provides you with effective protection against configuration errors. 
The master handles application data transfers independently. In addition 
you can also send new configuration data to a bus coupler. 
If in the status DE "Data Exchange" the master is sending new basic data 
to the slave and the responding telegram of the slave transfers the recent 
input data to the master. 
 
 

Communication 

Master to master 

Master slave 
procedure 
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The data exchange between the DP master and the DP slave is performed 
in a cycle using send and receive buffers. 
 

DP-Master

Input Output

CC 03 with DP-Slave

I/OCommunikation
Processor

buffer receive

PROFIBUS-DP

V-Bus

buffer send

V-Bus-Zyklus

PI

PQ

DP-Zyklus

 
PI: Process image of the Inputs 
PQ: Process image of the Outputs 
 

In one V-Bus cycle (i.e. VIPA backplane bus) all input data of the CC-CPU 
are collected in the PII and all output data from the PIQ are transferred to 
the output modules. After the data exchange is completed, the PII is 
transferred to the sending buffer (buffer send) and the content of the input 
buffer (buffer receive) is transferred to PIQ. 
 

In one PROFIBUS cycle the master contacts all its slaves with a data 
exchange. There the memory areas assigned to the PROFIBUS are written 
res. read.  
Afterwards the DP master transmits data of the input area to the receive 
buffer of the communication processor and the data of the send buffer is 
transferred into the PROFIBUS output area.    
The DP master to DP slave data exchange on the bus is repeated cyclically 
and does not depend on the V-Bus cycle. 

The principle of 
data transfer 
operations 

V-Bus cycle 

DP cycle 
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To guarantee a simultaneous data transfer the V-Bus cycle time should 
always be same or lower than the DP cycle time. 
In the delivered GSD you’ll find the parameter min_slave_interval = 3ms. 
Thus guarantees that the PROFIBUS data on the V-Bus is updated at least 
every 3ms. Though you are allowed to execute one Data Exchange with 
the slave every 3ms. 
 

Data is referred to as being consistent, if it has the same logical contents. 
Data that belongs together is: the high- and low-byte of an analog value 
(word consistency) and the control and the status byte with the respective 
parameter word required to access the registers.  
The data consistency of communication between periphery and control is 
basically secure within the complete range.  
PROFIBUS guarantees the consistency with the required length.  
Please take care for the correct type to take over the consistent data from 
the PROFIBUS master into the CPU. 
Hints for this are to be found in the manual of your PROFIBUS master. 
 

When a high-level master fails this is not recognized automatically by the 
CPU. You should always pass along a control byte to indicate the presence 
of the master thereby identifying valid master data.   
 

There is a wide range of diagnosis functions at PROFIBUS DP to allow a 
fast error localization. The diagnostics data are broadcasted by the bus 
system and summarized at the master. 
 

V-Bus cycle ≤≤≤≤ 
DP cycle 

Data consistency 

Restrictions 

Diagnosis 
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As transfer medium the CC 03 PROFIBUS system uses an isolated 
twisted-pair cable based upon the RS485 interface or a duplex photo cable. 
The transfer rate is for both methods max. 12Mbaud. 
 

The RS485 interface is working with voltage differences. Though it is less 
irritable from failures than a voltage or a current interface. The network 
may only be built up in linear structure. Your CC 03 includes a 9pin "DP" 
slot where you connect the CC 03DP slave into the PROFIBUS network as 
a slave. 
The bus structure under RS485 allows an easy connection res. disconnec-
tion of stations as well as starting the system step by step. Later 
expansions don’t have any influence on stations that are already 
integrated. The system realizes automatically if one partner had a fail down 
or is new in the network. 
 

Every partner of the PROFIBUS network has to identify itself with a certain 
address. This address may be exist only one time in the bus system and 
has a value between 1 and 125. 
At the CC 03 you choose the address via your software tool. 
 

To configure the slave connections in your own configuration tool, you’ve 
got all the information about your VIPA-modules in form of an electronic 
data sheet file. 
Structure and content of this file are dictated by the PROFIBUS User 
Organization (PNO) and can be seen there. 
Install this file in your configuration tool. Look for more information below 
under "Project engineering CC 03DP" or in the online help of the according 
tool. 
 
The following GSD-files are required: 
 
GSD required for 
VIPA_11x.GSD project engineering I/O components of CC 03 as  

"CPU 11x" at slave side 
VIPA04Dx.GSD connection CC 03DP as "CPU 11xDP" to master system 
 
 

Transfer medium 

PROFIBUS DP via 
RS485 

Addressing 

GSD files 
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Project engineering CC 03DP 
 

In opposite to a stand-alone slave, the CC 03 with DP slave is provided 
with an "intelligent PROFIBUS coupler".  
The "intelligent coupler" processes data that are stored in an in- res. output 
area of the CPU. This area and an area for status and diagnostics data are 
set in the properties of the 603-2CC2x. For in- res. output data, separated 
memory areas are used. These areas are handled with your PLC program.  
Due to the system, the address ranges that are occupied by the coupler 
are not monitored in the Siemens hardware configurator.  
Please take care to avoid address overlaps. 
 
Note! 
For configuring the CPU and the PROFIBUS DP master a thorough 
knowledge of the SIMATIC manager and the hardware configurator from 
Siemens is required! 
 

The address allocation and the parameterization take place in the SIMATIC 
manager from Siemens by means of a virtual PROFIBUS system. By 
including a GSD the functionality of the CC 03 is available in the SIMATIC 
Manager from Siemens. 
 

To be compatible with the SIMATIC manager from Siemens, you have to 
follow these steps: 
• Create a complete CPU 315-2DP with DP master system (address 2)   
• Add a PROFIBUS slave "VIPA_CPU11x" with address 1   

(VIPA_11x.GSD required) 
• Include the CC 03 (603-2CC21) at slot 0 of the slave. 
• Select PROFIBUS parameters for the CC 03. 
• Enter I/O periphery parameters. 
• Transfer project via MPI into the CC 03. 
 

 
At the master you have to execute the following steps: 
• Create CPU with DP master system (address 2)  
• For the CC 03 is in reaction equal to the CPU 11x DP, you have to add 

the PROFIBUS DP slave VIPA_CPU11xDP (VIPA04Dx.GSD required). 
• Enter the PROFIBUS in- and output areas starting with slot 0 in Byte 

res. words. 
 

Overview 

     

Configuration in 
the SIMATIC 
manager from 
Siemens 

Steps of the 
CC 03DP 
configuration 

Steps of the   
master 
configuration 
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The following illustration summarizes the project engineering at the slave 
and the master: 
 
CC 03DP (GSD: VIPA_11x.GSD)

PB-
Addr.:1

Slot          Module

   0           603-2CCxx

   1                
    .           Expansion
    .           Modules
    .
   3

PB-
Addr.:2

DP200V CPU21x

   0         Output (Bytes)

   1         Input (Bytes)

Mastersystem (GSD: VIPA04Dx.GSD)

315-2DP (2AF03-0AB0) 315-2DP (2AF03-0AB0)

Slot       Module

 
 

The following section describes the single steps for the slave project 
engineering. 
 

For the project engineering of the CC 03DP in a master system the 
following conditions must be met: 
• SIMATIC manager from Siemens is installed. 
• GSD-file of the CC 03DP is included in the hardware configurator.  
• Transfer possibilities between project engineering tool and CPUs are 

available. 
 

The hardware configurator is part of the SIMATIC manager from Siemens. 
It is used for project engineering. The modules that may be parameterized 
are listed in the hardware catalog. 
For the deployment of the PROFIBUS DP slave of the CC 03DP, you have 
to include the modules in the hardware catalog via the GSD-file from VIPA. 
 

Start the hardware configurator from Siemens. To include a new GSD, no 
project may be open.  
Open the file window for installing GSDs via Options > Install GSD ... 
The GSD-file VIPA_11x.GSD is to be found at the service area at 
www.vipa.com. 
Copy the GSD-file to the GSD-directory of your configuration tool. 
The installation starts with [Open].  
You'll find the modules from VIPA installed via the GSD in the hardware 
catalog under PROFIBUS DP > Additional field devices > I/O > VIPA.  

Relation between 
master and slave 

Configuration  
CC 03DP 

Conditions 

Install hardware 
configurator from 
Siemens  

GSD: 
Include 
VIPA_11x.GSD 
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• Create a new project system 300 and add a profile rail from the 
hardware catalog. 

• Insert the CPU 315-2DP. This PLC with PROFIBUS master is to find in 
the hardware catalog at: Simatic300 > CPU-300 > CPU315-2DP > 6ES7 
315-2AF03-0AB0. 

• Assign the PROFIBUS address 2 to your master. 
• Click on "DP" and choose the operating mode "DP master" under Object 

properties. Confirm with OK. 
• Via right-click on "DP", the context menu opens. Choose "Add master 

system". Create a new PROFIBUS subnet via NEW. 
The following picture shows the created master system: 
 

 
 

To be compatible with the SIMATIC manager from Siemens, you have to 
include the CPU 11xDP explicitly 
• Add the system CC 03DP to your subnet.  This is in the hardware 

catalog at PROFIBUS DP > Additional field devices > I/O > 
VIPA_System_100V. Assign the PROFIBUS address 1 to the DP slave. 

• Place your CC 03DP (603-2CC21) from VIPA in the hardware 
configurator at slot 0.  
The slot 0 is mandatory! 

Create a virtual 
PROFIBUS system 

Configure CC 03  
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• Parameterize the in-/output periphery. 

 
• The PROFIBUS section shows its data areas in the memory area of the 

CC-CPU. The allocation of these areas is fixed at the properties of the 
CC 03DP. Via a double-click on the 603-2CCxx the dialog window for 
parameterization of the data areas for the PROFIBUS slave may be 
opened. More detailed information may be found in the following at "DP 
slave parameters". 

 

Attention! 
Please take care of identical data areas length values at master and slave 
configuration. 
The data areas that are occupied in the CPU by the PROFIBUS section 
may only be monitored in the CPU parameter window.  
 

 
• Save your project. 
• Transfer your project via MPI into the CC 03DP.   

  
 

Continue 
configure CC 03  
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To engineer a master system on a higher level, you have to include the 
GSD: VIPA04Dx.GSD. 
• Start your configuration tool and project a PROFIBUS DP master that is 

leading your CC 03DP. 
• Add a DP slave system "VIPA_CPU11xDP" to the master. This is to find 

in the hardware catalog under: 
PROFIBUS DP > Additional field devices > I/O > VIPA >  
VIPA_System_100V.  

• Select a valid PROFIBUS address for your DP slave. 
• Assign memory areas of the PLC address range to the PROFIBUS 

section for the inputs and outputs in form of "modules". Input and output 
section always need an uninterrupted block of addresses! 

 
• Save your project and transfer it into the CPU of your master system. 
 

Note! 
When your DP master system is a System 200V from VIPA, you may 
parameterize the directly plugged-in modules by adding a "DP_200V_2" 
slave system.  
To enable the VIPA-CPU to recognize the project as central system, you 
have to assign the PROFIBUS address 1 to the "DP_200V_2" slave 
system! 
When deploying an IM 208 PROFIBUS DP master, please ensure that 
this has a firmware version > V 3.0; otherwise this is not compatible 
with the CPU 21x with a firmware version >V 3.0. The firmware 
version is to find on the label on the backside of every module. 
 

Project 
engineering in a 
master system 
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DP slave parameters 
 

"Intelligent" slave means that the PROFIBUS section includes its data 
areas into the memory range of the CPU. The allocation of the ranges 
takes place in the "Properties" of the CC 03DP. 
The in- res. output areas have to be supported with an according PLC 
program. 
 

Attention! 
The length entries for the input and output area have to be congruent with 
the Byte entry at the master project engineering. Otherwise no PROFIBUS 
communication is possible (slave failure)! 
 

CC 03DP (GSD: VIPA_11x.GSD)

PB-
Addr.:1

Slot          Module

   0           603-2CCxx

   1                
    .           Expansion
    .           Modules
    .
   3

PB-
Addr.:2

DP200V CPU21x

   0         Output (Bytes)

   1         Input (Bytes)

Mastersystem (GSD: VIPA04Dx.GSD)

315-2DP (2AF03-0AB0) 315-2DP (2AF03-0AB0)

Slot       Module

 
 

When you enter a length of 0, the according data do not occupy memory 
space in the CPU. 
Entering 1023 (memory limit) at the parameters PRN, DIAG and STAT you 
may also release memory areas of the CPU. 
 

Overview 

 

Release memory 
in the CPU  
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Via a double-click on the CC 03DP in the hardware configurator, the dialog 
window for the parameterization of the data areas for the PROFIBUS slave: 
 

 
 
Address, from where on the data coming via PROFIBUS have to be stored 
in the CPU with the according "length".  
When you enter a length of 0, the input areas do not occupy memory 
space in the CPU. The length is entered at the master in form of Byte 
groups for the PROFIBUS output section. 
 
Address, where the data that has to be send via PROFIBUS is starting. 
Here too, you define the data width with len. 
When you enter a length of 0, the input areas do not occupy memory 
space in the CPU. The length is entered at the master in form of Byte 
groups for the PROFIBUS input section. 
 
The parameter data is an excerpt of the parameter telegram. The 
parameter telegram is created at master engineering and sent to the slave 
when: 
• the CC 03DP is in start-up. 
• the connection between CC 03DP and master was interrupted, like e.g. 

disconnection of the bus connector. 
A parameter telegram consists of PROFIBUS specific data (bus para-
meters) and user specific data, where the in-and output bytes at the CC 
03DP are defined. 
The user specific data (Byte 7 ... 31) are shown in the memory area of the 
CPU with a fixed length of 24Byte starting with the address selected in prm. 
This allows to proof the parameters, which your slave gets form the master.  
 

Description 
parameter data 

Input add., length 

Output add., 
length 

Prm. Add. 
(24Byte fix) 
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The wide range of diagnostics facilities of PROFIBUS DP allow fast error 
localization. The diagnostics messages are transferred via the bus and 
collected at the master.  
The CC 03DP is sending diagnostics data either on master request or in 
error case. The diagnostics data contain:  
• Norm diagnostics data (Byte 0 ... 5), 
• Device related diagnostics data (Byte 6 ... 10) 
• User specific diagnostics data (Byte 11 ... 15) 
 
Via diag you define the start address of the 5Byte user specific diagnostics 
data in the CPU. 
With targeted access to this area you may initialize and influence 
diagnosis. 
 
Note! 
More detailed information about structure and possibilities with diagnostics 
messages is under "Diagnostics functions". 
 

The current status of the PROFIBUS communication can be seen in a 
2Byte status area, stored in the periphery address range of the PLC 
starting at the status address. 
 
Note! 
More detailed information about the structure of a status message is under 
"Status message internal to CPU". 
 

Via this parameter you assign a PROFIBUS address to your PROFIBUS 
slave. Please regard that every PROFIBUS address may be assigned only 
once! 
 

When entering the length 0, the according data do not occupy space in the 
CPU.  
You may also release memory areas in the CPU by entering the address 
range limit 1023 at the parameters PRN, DIAG and STAT. 
 
 

Diag. Add.  
(5Byte fix) 

     

Stat. Add.  
(2Byte fix) 

     

PROFIBUS DP 
address 

Release areas in 
the CPU 
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Diagnostics functions 
 

The wide range of diagnostics functions at PROFIBUS DP allow fast error 
localization. The diagnostics data is broadcasted via the bus and 
summarized at the DP master. 
The CC 03DP is sending diagnostics data either on master request or in 
error case. For a part of the diagnostics data is stored in the periphery 
address area (Byte 11 ... 15) of the CC-CPU, you may initialize and 
influence diagnosis. The diagnostics data contain: 
• Norm diagnostics data (Byte 0 ... 5), 
• Device related diagnostics data (Byte 6 ... 15). 
 

The diagnostics data have the following structure: 
 

Norm diagnostics data   
Byte 0 Station state 1 
Byte 1 Station state 2 
Byte 2 Station state 3 
Byte 3 Master address 
Byte 4 Ident no. (low) 
Byte 5 Ident no. (high) 

 
 

Device related diagnostics data 

 

Byte 6 length and code device related 
diagnosis 

Byte 7 device related diagnostics messages 
Byte 8 ... Byte 10 reserved 
Byte 11 ... Byte 15 User specific diagnostics data are 

shown in the CPU periphery address 
range and may be altered and send to 
the master. 

 

Overview 

Structure 
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More detailed information about the structure of the norm diagnostics data 
is available in the PROFIBUS Norm Papers. These papers are delivered by 
the PROFIBUS User Organization. 
The slave norm diagnostics data have the following structure: 
 

Byte Bit 7 ... Bit 0 
0 Bit 0: fixed at 0 

Bit 1: Slave not ready for data transfer 
Bit 2: Configuration data is not congruent 
Bit 3: Slave has external diagnostics data  
Bit 4: Slave does not support requested function 
Bit 5: fixed at 0 
Bit 6: Wrong parameterization 
Bit 7: fixed at 0 

1 Bit 0: Slave needs new parameterization 
Bit 1: Statistic diagnosis 
Bit 2: fixed at 1 
Bit 3: Response control active 
Bit 4: Freeze command received 
Bit 5: Sync command received 
Bit 6: reserved 
Bit 7: fixed at 0 

2 Bit 6 ... 0: reserved 
Bit 7: Diagnostics data overflow 

3 Master address after parameterization 
 FFh: Slave without parameterization 

4 Ident no. High Byte 
5 Ident no. Low Byte 

 

Norm diagnostics 
data 
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The device related diagnostics data give detailed information about the 
slave and the in-/output periphery. The length of the device related 
diagnostics data is fixed at 10Byte.  
 

Byte Bit 7 ... Bit 0 
6 Bit 5 ... 0: Length device related diagnostics data 

 001010: Length 10Byte (fix) 
Bit 7 ... 6: Code for device related diagnosis 
 00: Code 00 (fix) 

7 Bit 7 ... 0: Device related diagnostics messages 
 12h: Error: Parameter data length 
 13h: Error: Configuration data length 
 14h: Error: Configuration entry 
 15h: Error: VPC3 buffer calculation 
 16h: Error: missing configuration data 
 17h: Error: Compare DP parameterization with project 
 40h: User defined diagnosis is valid 

8 ... 10 reserved 

11 ... 15 User specific diagnostics data that are stored after the 
diagnostics status byte in the process image of the CPU. 
They may be overwritten and forwarded to the master. 

 

In case of diagnosis the contents of Byte 11 ... 15 of the device related 
diagnostics data are transferred into the process image of the CPU with the 
status byte as prefix. The position of this 6Byte diagnostics block in the 
process image of the CC-CPU is defined at the CC 03DP parameter 
adjustment.  
With a status change of 0  → 1 in the diagnostics status byte you initialize 
a diagnostics and the according diagnostics telegram is transferred to the 
master. The state 0000 0011 is ignored! 
The diagnostics block in the CC-CPU has the following structure: 

Byte Bit 7 ... Bit 0 
0 Diagnostics status byte: 

Bit 0: user specific diagnostics data 
 0: invalid diagnostics data 
 1: valid diagnostics data (initialize diagnosis) 
Bit 1: Delete diagnosis 
 0: Delete diagnosis invalid 
 1: Delete diagnosis valid 
Bit 7 ... 2: reserved 

1 ... 5 Bit 7 ... 0: User specific diagnostics data equal to 
         Byte 11 ... 15 of the device related diagnosis 

 
 
 

Device related 
diagnostics data 

Initialize diagnosis 
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Status message internal to CC-CPU 
 

The current status of the PROFIBUS communication is shown in the status 
messages that are included in the periphery address range of the CC-CPU. 
The status messages consist of 2Byte and have the following structure: 
 

7         0     Bit-No.

Status Byte 0

Clear Data
0: Communication processor in normal operation
1: Receive data cleared

reserved

User Parameter
0:  no valid parameters 
1:  parameter data found

Response control (active)
0:  Response control not active
1:  Response control activated by DP master 

Status PROFIBUS data transfer
0:  Data transfer error
1: Data transfer via PROFIBUS active

reserved

7         0     Bit-No.

Status Byte 1

Parameterization
0: valid parameterization
1: invalid parameter telegram from DP master

Configuration
0:  valid configuration data
1:  no congruence with DB1 parameters

Response control (Watchdog)
0:  Response control is not complete
1:  PROFIBUS response control has been completed

Hardware control
0:  PROFIBUS controller VPC3plus is ok
1: PROFIBUS controller VPC3plus is defect

DP data
0:  PROFIBUS slave is in state PROFIBUS data exchange
1: PROFIBUS slave waits for parameters from master

reserved  
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In error case, the send and receive buffers are deleted. 
 

These Bits are reserved for future expansions. 
 

Shows the validity of the parameter data. The parameter data are entered 
at the master parameterization tool. 
 

Shows the activation status of the response control in the next higher 
PROFIBUS master. When the response control time is exceeded, the slave 
terminated the communication. 
 

Status monitor of the communication with the higher master. With invalid 
configuration or invalid parameters, the communication is terminated and 
the error is shown via this Bit. 
 

Shows the status of the parameter data. The length of the parameter data 
and the number of parameter bytes is compared. Only if these are identical 
and not more than 31Byte parameter data are transferred, the 
parameterization is correct. 
 

Status monitor of the configuration data that are send by the PROFIBUS 
master. The configuration is created in the master project engineering tool. 
 

The status of the response control in the PROFIBUS master is monitored. 
When the response control is active and the response time in the slave is 
exceeded, an error is shown here. 
 

If a Bit is set here, this shows a failure in the PROFIBUS controller of the 
CC 03DP. Please contact the VIPA hotline. 
 

This Bit is set at a transfer error. 
 
 

Parameter 

Clear Data 

reserved 

User Parameter 

Response control 
(active) 

Status PROFIBUS 
data transfer 

Parameterization 

Configuration 

Response control 
(Watchdog) 

Hardware control 

DP data 
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PROFIBUS installation guidelines 
 

• A PROFIBUS DP network may only be built up in linear structure. 
• PROFIBUS DP consists of minimum one segment with at least one 

master and one slave. 
• A master has always been deployed together with a CPU. 
• PROFIBUS supports max. 126 participants. 
• Per segment a max. of 32 participants is permitted. 
• The max. segment length depends on the baud rate:  

9.6 ... 187.5kBaud → 1000m 
500kBaud  → 400m 
1.5MBaud  → 200m 
3 ... 12MBaud  → 100m 

• Max. 10 segments may be built up. The segments are connected via 
repeaters. Every repeater counts for one participant. 

• All participants are communicating with the same baudrate. The slaves 
adjust themselves automatically on the baudrate. 

• The bus has to be terminated at both ends. 
• Master and slaves are free combinable. 
 

• Assemble your PROFIBUS system with the concerning modules. 
• Configure your CC 03DP at the slave and the master. 
• Transfer your projects into the according CPUs. 
• Connect the PROFIBUS cable to the coupler and turn on the power 

supply. 
 

As transfer medium PROFIBUS uses an isolated twisted-pair cable based 
upon the RS485 interface.  
The RS485 interface is working with voltage differences. Though it is less 
irritable from influences than a voltage or a current interface. You are able 
to configure the network as well linear as in a tree structure. Your VIPA CC 
03DP includes a 9pin slot where you connect the PROFIBUS coupler into 
the PROFIBUS network as a slave. 
Max. 32 participants per segment are permitted. The segments are 
connected via repeaters. The maximum segment length depends on the 
transfer rate. 
PROFIBUS DP uses a transfer rate between 9.6kBaud and 12MBaud, the 
slaves are following automatically. All participants are communicating with 
the same baudrate.  
The bus structure under RS485 allows an easy connection res. 
disconnection of stations as well as starting the system step by step. Later 
expansions don’t have any influence on stations that are already 
integrated. The system realizes automatically if one partner had a fail down 
or is new in the network. 

PROFIBUS in 
general 

Assembly and 
inclusion in 
PROFIBUS 

Transfer medium 
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The following picture illustrates the terminating resistors of the respective 
start and end station. 
 

RxD/TxD-P(B)

Shield

Master Slave

3

8

3

8

P5V P5V

M5V M5V

330 330

330 330

220 220

3

8RxD/TxD-N(A)

5

6

RxD/TxD-P(B)

RxD/TxD-N(A)

Slave

RxD/TxD-P(B)

RxD/TxD-N(A)

5

3

8

6

Shield Shield

 
 

Note! 
The PROFIBUS line has to be terminated with its ripple resistor. Please 
make sure to terminate the last participants on the bus at both ends by 
activating the terminating resistor. 
 

In systems with more than two stations all partners are wired in parallel. 
For that purpose, the bus cable must be feed-through uninterrupted. 
Via the order number VIPA 972-0DP10 you may order the bus connector 
"EasyConn". This is a bus connector with switchable terminating resistor 
and integrated bus diagnostics. 

C

A

B

90°

A

B

0°

B

A

45°

 
 

 0° 45° 90° 
A 64 61 66 
B 34 53 40 
C 15.8 15.8 15.8 

     all in mm 

Bus connection 

     

"EasyConn" bus 
connector 
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Note! 
To connect this EasyConn plug, please use the standard PROFIBUS cable 
type A (EN50170). Starting with release 5 also highly flexible bus cable 
may be used: Lapp Kabel order no.: 2170222, 2170822, 2170322. 
Under the order no. 905-6AA00 VIPA offers the "EasyStrip" de-isolating 
tool, which makes the connection of the EasyConn much easier.  
 

11 6

       
Dimensions in mm  
 

The "EasyConn" bus connector is provided with a switch that is used to 
activate a terminating resistor. 

 
Attention! 
The terminating resistor is only effective, if the connector 
is installed at a slave and the slave is connected to a 
power supply. 
 
Note! 
A complete description of installation and deployment of 
the terminating resistors is delivered with the connector. 

 
 

 

 

• Loosen the screw. 
• Lift contact-cover. 
• Insert both wires into the 

ducts provided   
(watch for the correct line  
color as below!) 

• Please take care not to cause 
a short circuit between screen 
and data lines! 

• Close the contact cover. 
• Tighten screw   

(max. tightening torque 4Nm).
 
the green line must be connected to A, the red line to B! 

     

Termination with 
"EasyConn" 

Assembly 

Please note: 
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One CPU and several master lines 
The CPU should have a short cycle time to guarantee the actuality of the 
data in slave no. 5 (right side). This structure is only convenient when there 
are only slaves coupled to the slow line (left), which data actuality is not 
important. No alarm throwing modules should be placed here. 
 
 

I/O Periphery

CPU 11x DP

IM 253

I/O Periphery

IM 253

I/O Periphery

IM 208

PROFIBUS Master

I/O Periphery

CPU 21xDPM

CC 03 DP

CC03

SHIFT

ESC

ENTER

4321
F1 F2 F3 F4

Commander Compact

9876

5
F5

0

,
+/-

PWR

RUN

STP

DE

SF

CC 03 DP

CC03

SHIFT

ESC

ENTER

4321
F1 F2 F3 F4

Commander Compact

9876

5
F5

0

,
+/-

PWR

RUN

STP

DE

SF

 
 

Examples for 
PROFIBUS 
networks 
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Multi master system 
Several master connections at one bus together with several slaves: 
 

 

I/O Periphery

CPU 11x DP

CPU IM 208

CPU IM 208

IM 253

I/O Periphery

IM 253

I/O Periphery

CPU IM 208

IM 253

I/O Periphery

I/O Periphery

CC 03 DP

CC03

SHIFT

ESC

ENTER

4321
F1 F2 F3 F4

Commander Compact

9876

5
F5

0

,

+/-

PWR

RUN

STP

DE

SF
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Commissioning 
 

• Build up your components. 
• Project the CC 03DP as "CPU 11xDP" at the master.  
• Configure the CC 03DP with possible in-output periphery as "CPU 11x" 

at the slave section. 
• Connect the CC 03DP with the PROFIBUS. 
• Turn on the power supply. 
• Transfer your project into the respective CPUs   

(CC-CPU and Master-CPU). 
 
Install your CC 03DP and connect the cables like shown in the chapter 
"Deployment CC 03 - Operator panel". Link-up the CC 03DP to your DP 
master via PROFIBUS. 
 
Note! 
To avoid transfer irritations from reflections, the bus cable has always to be 
terminated with its ripple resistor at the cable ends! 
 

Project your CC 03DP as "CPU 11xDP" in your master system. To 
engineer you have to include the GSD VIPA04Dx.GSD. 
Transfer your project in the master PLC. 
 

Project your CC 03DP at the slave. You need the GSD VIPA_11x.GSD.  
The in-/output periphery is automatically overlaid in the CPU address 
range. The address allocation may be altered in the hardware configurator 
from Siemens at any time. 
Transfer your project via MPI in the CC 03DP. 
 

The CC 03DP has an integrated mains power supply. It has to be provided 
with DC 24V.  
Via the supply voltage not only the CC 03DP and the bus coupler is 
provided but also the connected modules via the backplane bus. Please 
regard that the internal power supply may provide the backplane bus with 
max. 800mA.  
PROFIBUS and backplane bus are isolated. 

Overview 

Assembly 

     

Configuration at 
the master 

Configuration CC 
03DP and 
I/O periphery 

Power supply 
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The transfer of the hardware configuration into the CC 03DP takes place 
via MPI. 
• Connect your PG res. the PC via MPI with the CPU.  

If your programming device has no MPI slot, you may use the VIPA 
Green Cable to establish a serial point-to-point connection. 
The Green Cable has the order no. VIPA 950-0KB00 and only be used 
with the VIPA components. 

• Configure the MP interface of your PC. 
• With PLC > Load to module in your projecting tool, you transfer your 

project into the CC 03. 
• For the additional security copy of your project on MMC, you plug-in a 

MMC and transfer the user application to the MMC via PLC > Copy 
RAM to ROM.  
During write operation the MC-LED on the PLC blinks. Due to the 
system, the successful writing is signalized too soon. The write 
command has only been completed, when the LED extinguishes. 

 

Attention! 
Please regard the hints for deploying the Green Cable and the MP2I jack at 
chapter "Deployment CC 03 - CPU part". 
 

After the start-up, the CC 03DP executes a self-test. It proofs its internal 
functions, the communication via backplane bus and to PROFIBUS. 
At successful test the parameters are read from the PLC and the 
PROFIBUS slave parameters are proofed. 
After successful boot procedure the PROFIBUS part of the CC 03 PD 
switches to "READY". 
Communication problems at the backplane bus cause the CC-CPU to go in 
STOP and start again after app. 2 seconds. When the test has been 
completed positive, the RD-LED blinks.  
At starting communication, the DE-LED is on. 
 
 
 
 
 
 
 
 

Transfer project 

 

Initialization phase 
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Chapter 5 Functions operator panel 
 

This chapter informs you about the functionalities of the operator panel. 
Especially referred to is to the functions that are part of the standard 
project. 
The text describes how you access screens, use operating keys, react to 
messages, alter values and use the password protection. 
 

 

Topic     Page 
Chapter 5 Functions operator panel ............................................... 5-1 

Screens................................................................................................ 5-2 
Standard project with standard functions.............................................. 5-4 
Process depending operation............................................................... 5-5 
Messages........................................................................................... 5-12 
Timer and Counter ............................................................................. 5-15 
Operating mode.................................................................................. 5-16 
StatVAR and ForceVAR ..................................................................... 5-17 
Password protection........................................................................... 5-19 

 

Overview 

Content 
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Screens 
 

To monitor the process execution, the operator panel uses "Screens". A 
screen consists of a matrix of 2x20 characters that corresponds to the size 
of the display. 
You may program this screens in the OP-Manager. 
Screens collect logical matching process values and give you an overview 
over a process or an installation.  
The screens allow you to enter process values and thus control the 
process. 
To structure your process, you may develop up to 40 screens with up to 20 
entries where you can branch if needed. 
  

Screens consist of entries. Every screen can contain several entries. 
Always one entry is shown per display page.  
If existing, a not ready programmed row is monitored in the display as 
empty. A screen may include the following elements: 
• Message and description texts like e.g. explanations for the user. The 

texts may also contain information about the soft key functions. 
• Fields for in- and output of date, time, effective value and set point. 
• Definitions of the soft keys that are programmed to different function 

calls depending on the screen. 
 

You may enter values in a screen. Use the following approach: 
• Choose the screen you want to alter.  
 → The cursor jumps to the first input field. 

• Move the cursor with  res.  to the according field and enter the 
wanted value. 

• Confirm your entry with . 
• Repeat this for all values that you want to alter. 
• Finish the change e.g. with ESCAPE. 
 

During the operation, you may access screens via programmed soft keys or 
via integrated special functions. 
At the project engineering in the OP-Manager, the main screens are 
collected in a screen contents list under "Screens" and listed with name 
and screen number. 

Overview 

Screen 
components 

Alter screen 

Screen  
contents list 



Manual VIPA HMI Chapter 5   Functions operator panel 

HB116E - CC 03 - Rev. 15/04  5-3 

During the project engineering in the OP-Manager you may set a poll rate 
for every variable that defines the interval for the variable update. 
Please regard that the lowest poll rate is decisive for the complete screen 
entry. 
To optimize your project engineering, you should: 
• program the poll rate as high as possible (min. 1 second). 
• program low poll rates only for critical variables. 
• refer to only one CPU per entry. The OP 03 allows a max. of 2. 
 

Output fields display effective values of the control in numeric or symbolic 
format. Input fields enter set points in numeric or symbolic format. In input 
fields you can see the blinking cursor. 
For symbolic in- and output fields, you may configure up to 256 texts where 
you can choose from via a selection field. The selected text is taken over. 
For numeric value entries, configured number formats res. limit values are 
valid, regarding the number of digits in front and behind the comma. 
 
 
The operator panels have two different operating levels that you may use. 
Screen level:  
The screen level serves the selection, operation and execution of functions. 

You reach the screen level via . The first screen is the so-called start 
screen. From here, you can branch, depending on the project engineering, 
into other screens. The screens display recent process values, you may 
enter values and initialize functions via the soft keys. 

Jump back to the message level with . 
At messages, the operator panel branches into a temporary message level. 

As soon as you acknowledge every message with , the panel jumps 
back to the previous screen. 
If several messages are waiting for acknowledgement, you may switch 

between them with  res. . 
Message level:  
The message level displays recent messages like incoming operating and 
system messages. 
After start-up, the operator panel switches to the message level. 
 
 

Automatical 
update of values 

In- and  
output fields 

Screen level and 
message level 
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Standard project with standard functions 
 

The project engineering tool OP-Manager allows you to load a "standard 
project". This project contains all functions available via standard screens. 
This project remains active also after a RESET of the operator panel. 
As long as no project engineering is loaded res. after a RESET, the 
following standard project is activated with English dialogs. 
 

Screens System StatVAR PasswordForceVAR

Counter
Timer

OP-Mode
Language
Dat/Time
MPI-Adr

Logout
Edit

+ + + + +

StatVar ForceVar

 
 

The call of screens of the standard project happens via soft key. Depending 

on the project engineering, you have to use the  key additional to the 
soft key. 
The following standard screens are part of the standard project:  
 
• Screens 

Via "Screens" you can enter a screen contents list that shows all 
screens that have been marked at the project engineering with the 
attribute "Screen to Directory" (Contents list). Without further 
programming, the contents list displays the two standard screens 
"Counter" and "Timer". 

• System 
"System" allows you the access to the system settings. You may 
choose, for example, the operating mode, the language or set date and 
time. 

• StatVAR 
This function starts the PG function STATUS VAR that allows you to 
display operands of the destination CPU. 

• ForceVAR 
This function starts the PG function STEUERN VAR that allows you to 
display and alter operands of the destination CPU. 

• Password 
Here you may set up to 20 passwords for up to 9 different password 
level.  

 

Standard project 
after RESET 

Functions in 
standard screens 
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Process depending operation 
 

The project engineering allows you to adjust the screen hierarchy to the 
installation specific needs by adding, coupling or removing screens. 
During the project engineering you define the start screen, structure, 
sequence of the coupling, entry in the contents list and the return 
destinations.  
The branch into several screens happens via soft keys and programmed 
return destinations. 
 

The screen number area is in the CPU. Here the operator panel stores the 
number of the recent called screen.  
As soon as the CPU writes a number into this are, the according screen is 
displayed at the operator panel. 
If you want to use the screen number area, you have to configure this in the 
OP-Manager. Create the screen number area in the project object group 
via the register "Area Pointer". 
Choose the register "Area Pointer" and create a new object with the type 

"Screen number" via  and assign a DB or a bit memory area.  
The screen area consists of a double word and has the following structure: 
 

Double word Byte 0 Byte 1 
 Bit 7 Bit 6 ... 0 Bit 7 ... 0 

1. DW (Display content) Bit 7 = 1 (ID for special screen) Screen number Entry number 
2. DW (CPU entry) Bit 7 = 1 (ID for special screen) Screen number Entry number 

 
The first data word is filled by the operator panel with information about the 
monitored display content. 
As soon as the CPU writes a screen and entry number into the second data 
word, the according screen is displayed at the operator panel with the 
concerning entry. 
The entry FFFFh in the 1. or 2.DW marks the message level. 
As soon as a 0 is in the 2.DW, your operator panel is ready for employ-
ment. 
 
 

Screen hierarchy 

Evaluation of the 
screen number 
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When the highest valued bit is set in the DW of the screen number area 
("1"), a special screen is displayed. 
When the highest valued bit in the DW of the screen number area is 
deleted ("0"), a user specific screen is displayed. 
 

Screen number Special screen 
0 Screen contents list 

25 (19h) Status Variable 
26 (1Ah) Control Variable 
30 (1Eh) Language selection 
31 (1Fh) Change operating modes 
35 (23h) Set Date/Time 
36 (24h) MPI address/Baud rate 
55 (37h) Password Login 
56 (38h) Password Edit 

 
 

An example shows you the screen selection of screen number 2.  
 
 

The operator panel shows a not specified screen. 
 
 
 
 
To recognize and overtake an alteration, your user application 
must write a "0" to the 2. DW of the screen number area. 
 
 
 
At the earliest after one poll cycle (1 second) your user 
application may transfer the value 2. 
 
 
 
The operator panel recognizes the change from 0 to 2 and 
displays the according screen. For control purposes, the screen 
number is written to the 1. DW. 
 

 

Special screens 

Example for 
screen selection 
via CPU 

 Screen 
No. 

Entry No. 

1. DW x x 
2. DW x x 
 

 Screen 
No. 

Entry No. 

1. DW x x 
2. DW 0 x 
 

 Screen 
No. 

Entry No. 

1. DW x x 
2. DW 2 x 

 Screen 
No. 

Entry No. 

1. DW 2 x 
2. DW 2 x 
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At the front side there is a foil keyboard with 18 short click keys. 8 keys 
serve the navigation and 10 are numerical keys where 5 can be 
programmed as function keys. 
When you push a function key, a bit is set into a bit memory byte of your 
CPU. By requesting the bit memory byte in your PLC application, you may 
react to an entry. 
The numeric and cursor keys are provided with a repeat function. If you 
hold the key down, the key is after a short delay time repeated as long as 
you push the according key. 
 
Note! 
If you push several keys fast consecutively, some entries may get lost. Not 
received keys are signalized via an acoustic signal. 
 

Numerical keys 
The numeric keys enter numeric digits (0...9). 
 

Soft keys (F1 to F5)  
The numeric keys 1 ... 5 may be configured as soft keys, i.e. this keys can 
be programmed with screen depending functions. You enable the soft key 
functions by pushing the SHIFT key and simultaneously one of the keys 1 
to 5. 
 

SHIFT key  

Switches to the second function of double programmed keys.  is 
pushed simultaneously with another key. 
 

Math sign key 

 allows you to change the math sign res.  +  to set a comma. 
 

ENTER key (Return)  
This key confirms and finishes an entry. ENTER also switches from the 
message to the screen level. 
 

Keyboard input 

     

  ...   
 
 
 

 
 

+ 
 

 
 

...  
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ESCAPE key   
This key allows you to: 

• clear field entries as long as they have not been confirmed with . 
• branch back from the start screen to the message level or within a 

screen to a defined jump back destination. 
• interrupt the leafing of messages and display of the recent message. 
• leave a system message. 
 

For the navigation, the following keys are available: 

 res.  navigation to previous res. next screen 

 res.  navigation to previous res. next screen 

Push additional  to navigate horizontal within a screen  

with  res.  and to choose a character from the character set that can 

not be entered via keyboard with  res.  e.g. at Hex input. 
 

Push simultaneously the key combination + +  before turning on 
and during the boot time to reach the SETUP where you can alter basic 
functions. 

The navigation happens with  res. , The selection with .  
leaves the SETUP again. 
 

The display contrast is set in the SETUP using  +  res. . 
 

Navigation 

Enter the SETUP 

Set display contrast 
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The SETUP provides the following functions:  
• Setup default prog 

This function overwrites the recent project engineering with the standard 
project. 

• Download from PC 

This function enables the operator panel to receive engineering data 
from the OP-Manager via MPI. 
In delivery state your operator panel has the MPI address 1. 

To control the MPI address you may also leave the SETUP with 2x  

and display via  SYSTEM  >>  MPI-ADR  the MPI 
address and baud rate. Alteration of this values happens in the OP-
Manager via the project engineering.  
To return to the SETUP, you have to turn off the operator panel and turn 
it on again pushing the shown keys. 

Choose Download from PC and push . 
After the data transfer has finished, the data is proofed and stored in the 
memory. When executed with OK, your operator panel starts again with 
the new project engineering. 

• Display error log 

All error codes stored in the operator panel are displayed. 
 
 

Note! 
Please regard that some functions like e.g. "Download from PC" are 
already included in the standard project. By including it into your project, 
you may use them as soft key functions without setup call.  
 

The keys  ...  can be programmed as soft keys in your project 
engineering tool and be configured with screen depending functions.  
The access to the soft keys can be programmed for usage with or without 

additional  key. This can be set via  in the OP-Manager. 
 

Functions of the 
SETUP 

     

Soft keys 
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You can reserve a data area in your CPU for the system keyboard. Every 
key uses one Bit. By according evaluation your user application may react 
to key pushes. 
If you want to create a data area for the system keyboard, you have to 
configure it in the OP-Manager. Choose for this the register "Area Pointer" 
in the project object group. 

Create a new object of the type "System Key Assignment" with  and 
assign a DB or bit memory area. The keyboard data area consists of a 
double word and has the following structure: 
 
 

 Byte 0 Byte 1 
Bit 7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 

1. DW   
 

 
 

      
 

   

2. DW Sum bit      9 8 7 6 5 4 3 2 1 0 
 
 
The sum bit 7 in the 2. DW serves as control bit. At every transfer of the 
keyboard image from the operator panel to the CPU it is set to the value "1" 
and should set back from your user application after evaluation.  
 

Input fields allow you to enter values that are transferred to the control. 
 
1. Branch into the wanted screen and there to the according screen entry. 
2. Use the cursor keys to select the wanted input field. 
3. Enter the wanted value. Depending on the project engineering of the 

field you may enter values as:  
- numeric values  
- alphanumeric values  
- symbolic values 

4. Confirm your entry with .  

Clear a wrong value with .  
The original value it then set back into this field. Repeat the entry with 
the correct value. 

5. Leave the screen entry with . 
 

System keyboard 
image 

Value entries 

Approach 
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Input fields that allow the entry of numeric values are filled via the number 
field of the keyboard digit per digit. An already started input can only be 

confirmed with  or aborted with . 

To enter a decimal value, use  + . 
An already entered value is automatically deleted. 
The input is linked to the right side. Entered digits are added right. Input 
fields in bit pattern format are linked to the left. Existing values are 
overwritten from the left. 

Move here the cursor with  and  res. . 
 

The OP-Manager allows you to set limit values and number formats for 
numeric input fields. These fields execute a limit value evaluation. The 
values you enter are only accepted if valid and within the defined range. If 
you enter a value exceeding the range, a system message appears. After 
abort, the previous value is displayed. 
If the format of a numeric field has been set to a certain number of digits 
after the comma, empty places are filled with a 0, too many digits are 
ignored after acknowledgement. 
 

Alphanumeric values contain digits as well as characters. Enter the digits 
like shown above.  
If you want to enter a character at the cursor position, you have to activate 

the alphanumeric character set. Push  and choose the according 

character via  res. . 
 

Symbolic values are texts res. value that can be chosen from a selection 
list.  

Push  and choose the according entry via  res. . Confirm with 

. 
 

Numeric values 

Number formats 
and Limit value 
evaluation 

Alphanumeric 
values 

Symbolic values 
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Messages 
 

Events and states of the control process are shown on the operator panel 
as messages.  
Normally, a message consists of a static text and if wanted additionally 
variables. Messages can be: 
• configurable operating messages that are initialized by the CPU, 
• (error-) system messages that are initialized by the operator panel. 
 

Operating messages contain process related information in form of static 
text and variable fields like e.g. messages about states or processes of an 
installation. Here you may display e.g. recent control effective values in 
numeric or symbolic format. You may configure operating messages as 
status messages as well as operating hints. 
 
 
The output of a message happens event triggered. As soon as an event 
takes place in the specified CPU, the according message is shown, sorted 

after priority. Acknowledge every message with . Please regard that 
you first have to configure the event in your project object group in the 
register "Area Pointer", if you want an event to cause a message.  
Select the register "Area Pointer" and create a new object of the type 

"Event Messages" via . Assign a DB or bit memory area. For every bit 
in the operating message area you may configure one operating message. 
The operating message area can be divided in up to 4 address ranges. The 
address ranges need not to be in sequence. The assignment of message 
number and bit number happens automatically like shown in the picture: 

 

7 6 5 4 3 2 1 0

8 7 6 5 4 3 2 1

15 14 12 11 10 9 8

16 15 14 13 12 11 10 9 Message no

Message no

Bit number

Bit number

Address
range

13

7 6 5 4 3 2 1 0

24 23 22 21 20 19 18 17

15 14 12 11 10 9 8

32 31 30 29 28 27 26 25

13

7 6 5 4 3 2 1 0

40 39 38 37 36 35 34 33

15 14 12 11 10 9 8

48 47 46 45 44 43 42 41

13

Message no

Bit number
Address
range

.

.

.  

Overview 

Operating 
messages 

Configure 
operating 
message 
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When your operator panel is on message level and there is no message 
waiting, "Standby" is displayed as operating message. The standby 
message is stored in the firmware and contains per default release version 
and device type. You may change the content of the standby message via 
the message number 0 in the OP-Manager. You may display altered text, 
date and time but no variables. 
 

System messages display internal operating states of the operator panel. 
They may monitor e.g. wrong handling or communication problems. This 
message type has the highest display priority. If a failure occurs, the 
recently displayed operating message fades and the system message is 
shown. 
 

A "heavy" system message requires a reboot of the operator panel. 
 

All other errors cause normal system messages. The display of a normal 

system message can be aborted at any time with . You return to the 
screen before.  
The OP-Manager allows you to deactivate the output of system messages 
and preset the display duration. 
After timeout the operator panel jumps automatically back to the previous 
screen. 
 

System messages always have the highest display priority. 
Operating messages are displayed after message priority. 
You may configure the priority for the operating messages during the 
project engineering, depending on the importance from 1 (low) to 4 (high). 
If several messages with the same display and message priority occur, the 
latest message is always shown first. 
 
Reception sequence Display sequence 
1. Operating message A (Priority 2) 1. System message A 
2. Operating message B (Priority 3) 2. Operating message D (Priority 4)
3. Operating message C (Priority 2) 3. Operating message B (Priority 3) 
4. System message A 4. Operating message C   

(new with Priority 2) 
5. Operating message D (Priority 4) 5. Operating message A    

(older with Priority 2) 
 

Standby message 

System 
messages 

"Heavy"  
system message 

Normal  
system message 

Display priority 

Example 
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The message buffer contains the last 50 messages in sequence of their 
reception. 
If the message buffer is filled, the oldest message is deleted. If there are 
more than 50 messages (message rush), only the recent 50 are shown in 
the message buffer. It is not possible to monitor more than 50 messages. 
 

If no system message is waiting, you may scroll up down with  res. . 
between waiting operating messages, which are displayed in the sequence 
of their reception and sorted after priority.  
 
Shows the next older (lower priority) message. After the oldest message of 
one priority group, the newest message of the next lower priority is 
displayed. "↓↓↓ " marks the end of the messages. 
 
Shows the previous (higher priority) message. After the newest message of 
a priority group the oldest of the next higher priority group is displayed. 
"↑↑↑ " marks the end of the messages. 
 
Jumps back to the recently waiting message. This automatically happens 
also after 1 minute delay time. 
 
 
 

Via the option "Language Assignment", the OP-Manager allows you to 
select up to 3 of 8 languages for screens and operating messages. Choose 
the according language in the OP-Manager and configure the according 
screens and messages. Now you may adjust screens and message text in 
the available up to 3 languages. 
The texts for the system messages in 8 languages are fix integrated in the 
operator panel. The text output depends on the language that is set at the 
operator panel.  
You may choose one of the 3 configured languages at any time during 
operation. To switch the language, you may choose System > Language 
enter your password (Standard: 100) and change the language. The 
selected language must be programmed before. 
After the language selection, the operator panel restarts and all language 
related texts are displayed in the selected language. 
 
 
 

Message buffer 

Scrolling 

 

 

 
 

Languages 
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Timer and Counter 
 

Your operator panel allows you access to timer and counter of the CPU. 
You may only set time res. counter values. Start res. stop of timer and 
counter are not possible.  
Examples for that you may see in the standard screens. The access to 
timer and counter happens via the standard screens "Timer" and "Counter". 
 

You may display the recent effective value for every programmed and in 
the CPU activated timer function. Examples are to find in the standard 
project under screens. Choose the standard screen "Screens" → "Timer" in 
the standard project.  
The display shows: 
Set point 0.00  Timer 1 
Effective value 0.00 

The 1. row shows the recent timer value. The 2. row allows you to enter a 
set point. 

 leaves the screen. 
 

The common time base for every timer is configurable (10ms, 100ms, 1s or 
10s). Your operating device recognizes the chosen time base and 
nominates the display value to seconds. 
  

The operator panel process date and time internally. 
Please regard that the OP 03 has no integrated clock. You have to enter 
date and time after every reboot.  
 

The standard project allows you via System > Dat/Time to alter date and 

time. Switch between date and time with  res. . Within an input field 

you may navigate with  +  res. . 

Confirm the entered value with .  
 
 
 
 
 

Overview 

Effective value 
and set point 

Time base 

Date and time 

Alter date and time 
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Operating mode 
 

Your operator panel is provided with integrated system functions that allow 
you to set the operating mode of the panel. 
The following operating modes are available: 
• Online 
• Offline 
• Transfer 
 

Your operator panel always starts in the operating mode "Online". The 
operating mode "Online" means a logical connection between operator 
panel and CPU res. it is tried to establish a connection. 
 

"Offline", your operator panel works separately from the CPU. No 
connection establishment is tried. Thus allows you to suppress CPU error 
messages for test purposes.  
 

The operating mode "Transfer" initializes the operator panel to receive a 
project engineering via MPI. As communication parameter, the parameters 
defined at "MPI-Adr" in your operator panel are used.  
When your operator panel is in the operating mode "Transfer", you may 
connect your PC via MPI and transfer your project online from the OP-

Manager. You may interrupt the transfer at any time via . 
For the connection, you may use either an MPI adapter or the "Green 
Cable" from VIPA for a serial point-to-point connection. When using the 
Green Cable you have to set the transfer rate in the OP-Manager to 
38400 Baud.  
 
Note! 
Please regard that the online project engineering is only available with a 
licensed version of the OP-Manager! 
 

In the standard project, the operating mode setting is under System > 
OPMode. 

Change the operating mode with  +  res. . This function requires 
a password. The password of the standard project is 100. 
 

Overview 

Online 

Offline 

Transfer 

     

Navigation 
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StatVAR and ForceVAR 
 

The functions StatVAR and ForceVAR allow you to monitor res. alter 
operand values of a connected CPU. So you may alter control operands 
directly during online operation. 
• StatVAR monitors the operands of the CPU 
• ForceVAR monitors the operands of the CPU and allows you to alter 

them. You may not use ForceVAR to fix values but only alter them 
during runtime. 

 

Note! 
The functions StatVAR and ForceVAR are to find in the standard project. 
 

In the standard project these functions are password protected. The 
password is 100. Starting from the message level, you see both functions 
like shown in the menu structure: 
 

Screens System StatVAR PasswordForceVAR

Counter
Timer

OP-Mode
Language
Dat/Time
MPI-Adr

Logout
Edit

+ + + + +

StatVar ForceVar

 
 

After the call of StatVAR res. ForceVAR you need the MPI address of the 
destination CPU. Default address is address 2. 
At the OP 03, this 2 functions give you the opportunity to connect an 
additional CPU to complete the already configure ones.  
 

Overview 

     

Start 

MPI address 
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After entering the MPI address, you reach the operand field with the cursor 

key .  

Push  and choose with  or  the data type that you want to 

display.  sets automatically the according data format in the format field. 

The key  brings you to the numeric input field. Use the numeric key 
block to type the number of the operand to monitor res. at ForceVAR the 

operand to monitor and alter and confirm with . 
Every operand value that shall be monitored or altered has to be defined in 
a "Screen". You may create up to 10 screens. 
Within a screen res. a value field you navigate the blinking cursor with the 
arrow keys.   

Confirm your entries for every field with . The values of the displayed 
operands are shown in the preset format in the value field. 
 

The key combination  +  deletes single rows. 
 
After you've altered the operand list, the values in the control must be 
updated. This happens immediately after the verification of a single value. 
When you press the enter key again after the last confirm of your entries, 
the new values are transferred to the control. 
 

Note! 
During the status update, a blinking * is shown in the right upper corner of 
the display. If the star is not blinking, no logical connection to the control is 
established. 
During the update process, no entries are permissible.  

You may interrupt the update at any time via . 
 
 
 

Key functions 

 

 +  
 

 

 +     
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Password protection 
 

To avoid unauthorized access, the operator panel provides an integrated 
password protection. This includes the definition of passwords for up to 8 
password level. The assignment of the password levels happens in the OP-
Manager. With raising importance of the functions you may set a password 
level from 0 to 9 at the project engineering of soft keys. 
Enter Level 0 to deactivate the password request. 
A password of the level 9 gives you access to all other password levels. 
This "Supervisor-Password" is set in the project engineering. 
The passwords for the levels 1 to 8 are exclusively set in the operator 
panel. The screen "Password" is required in your project (see standard 
project). 
 

The Supervisor-Password gives you access to all functions of your operator 
panel. The Supervisor-Password is transferred to the operator panel 

together with the project. To enter a Supervisor-Password click on  in 
your project. The following dialog window appears: 
 

 

Set a password under "Supervisor" and 
define via "Logout Time" how long after 
the login the password will be valid. 
 

 

You may set a password level for every soft key definition like shown in the 
picture.  
 

 

Please regard that the password levels for 
integrated standard screens of the 
operator panel are fix like e.g.: 
Level 9: Password Edit, OP-Mode     
Level 8: ForceVAR     
Level 0: StatVAR, Password>Logout 
 
More detailed information see following 
page. 

Overview 

Set Supervisor-
Password 

Set  
password level 
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Precondition 
You've included the screen "Password" into your project and you know the 
Supervisor-Password. 
Approach 
• Load your project into the operator panel. 

• Press  and navigate to the screen "Password". Via "Edit" you reach 
the password dialog. The password alteration is protected with the 
Supervisor-Password. In delivery state, the password is 100. Please 

regard that you may have to push  additional to the digit 1 depending 
on the project basic settings. 

• Enter the password and confirm with . 
Now you reach a table where you may enter a password for every level. 
For you may store up to 20 password assignments in the table, you may 
also assign more than one password to a level.  
The password must have at least 3 digits and max. up to 8 digits. 
Characters and leading zeros are not permissible.   
The table has the following structure:  

 
No. Password Level 
0 ______100  9     
 (Supervisor-Password) 
1 _________  0 

. 

. 

. 
20 _________  0 

 

The navigation happens with the arrow keys. You have to confirm every 

entry with . To delete a password, write a 0 (zero) over the password. 
The Supervisor-Password cannot be deleted. 

 finishes the password entry and brings you back to the password 
screen. Via "Logout" you activate the passwords. 
 

Please regard that the password levels for the following integrated standard 
screens are fixed in the operator panel: 
 
Level 9:  Password Edit, OP-Mode     
Level 8:  ForceVAR     
Level 6:  System>MPI-Adr 
Level 4:  System>Dat/Time 
Level 2:  System>Language 
Level 0:  Screens, StatVAR, Password>Logout 
 
 
 

Set password at 
the operator panel 
for level 1 to 8 

Navigation and 
delete password 

Fixed password 
levels 
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Chapter 6 General installation guidelines 
 

The chapter gives you information about the interference-free installation of 
Programmable Logic Controls (PLC) together with a CC 03. 
Here we describe possible paths how interference can enter the controller, 
how you ensure the electromagnetic compatibility (EMC) and how to 
approach shielding and screening issues. 
 

 

Topic     Page 
Chapter 6 General installation guidelines ...................................... 6-1 

Basic rules for the EMC-equitable assembly of installations ................. 6-2 
EMC-equitable assembly...................................................................... 6-6 
EMC-equitable cabling ......................................................................... 6-7 
Special precautions providing high noise immunity............................. 6-11 
Checklist for the EMC-compliant installation of controllers.................. 6-12 
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Basic rules for the EMC-equitable assembly of installations 
 

The term electromagnetic compatibility (EMC) refers to the ability of an 
electrical device to operate properly in an electromagnetic environment 
without interference from the environment or without the device causing 
illegal interference to the environment.  
 
The Operation Panels are developed for applications in harsh industrial 
environments and complies with EMC requirements to a large degree. In 
spite of this you should implement an EMC strategy before installing any 
components, which should include any possible source of interference. 
 

Electromagnetic interference can enter your system in many different ways: 
 

 
 
 
Interference is coupled into your system in different ways, depending in the 
propagation medium (conducted or not conducted) and the distance to the 
interference source. 
 
We differentiate between: 
 
• galvanic coupling 
• capacitive coupling 
• inductive coupling 
• radiated power coupling 
 
 

What is EMC? 

Possible sources 
for disturbances 
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The following table shows the four different coupling mechanisms, their 
causes and possible interference sources. 
 

 
Coupling mechanism Cause Typical source 
Galvanic coupling 
 

Automation
System

galvanic
coupling line

Disruptor

 

Galvanic or metallic coupling 
always occurs when two 
current circuits have a 
common line 

• Pulsed devices 
(Net influence from 
transducers and foreign net 
devices) 

• Starting motors 
• Different potential of 

component cubicles with 
common current supply  

• Static discharges 

Capacitive coupling 
 

Automation
System

Disruptor

capacitive
coupling line

 

Capacitive or electric coupling 
occurs between conductors 
with different potential.  
The coupling is proportionate 
to the time characteristics of 
the voltage. 

• Interference through 
parallel signal lines 

• Static discharge of the 
personnel 

• Contactors 

Inductive coupling  
 

Automation
System

Disruptor

inductive
coupling
linewanted signal

 

Inductive or magnetic coupling 
occurs between two current 
active line loops.  
The magnetic flows associated 
with the currents induct 
interference voltages.  
The coupling is proportional to 
the time characteristics of the 
current. 

• Transducers, motors, 
electric welding devices 

• Parallel net cables 
• Cables with toggled 

currents 
• Signal cable with high 

frequency 
• Unused coils 

Radiate power coupling 
 

Automation
System

Disruptor

radiated
coupling 
line

 

One talks of radiate power 
coupling, when an 
electromagnetic wave meets a 
line circuit.  
The hit of the wave inducts 
currents and voltages. 

• Sender in the neighborhood
(e.g. walkie-talkie) 

• Sparking lines 
(sparking plugs, collector of 
electric motors, welding 
devices) 

 

Coupling 
mechanisms and 
interference 
sources 
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In many cases, adherence to a set of very elementary rules is sufficient to 
ensure EMC. For this reason we wish to advise you to heed the following 
rules: 
 
During the installation of your automation units you should ensure 
that any inactive metal components are grounded via a proper large-
surface earth 
 
• Interconnect any inactive metal components via low-impedance 

conductors with a large cross-sectional area. 
• Execute screw connections at coated and anodized metal parts either 

with special contact washer or remove the isolating protective film. 
• Install a central connection between the chassis ground and the 

grounding/protection system. 
 

Ensure that cabling is routed properly during installation 
 
• Divide the cabling into different cable groups (High voltage lines, power 

supply lines, signal lines, data lines). 
• Always install high voltage lines and signal or data lines in separate 

channels or bundles. 
• Install signal and data lines as close as possible to any metallic ground 

surfaces (e.g. frames, metal rails, sheet metal). 
 

Ensure that the screening of lines is grounded properly 
 
• Data lines must be screened. The screen has to be laid both-sided. 
• Analog lines must be screened. Where low-amplitude signals are 

transferred it may be advisable to connect the screen on one side of the 
cable only. 

• Attach the screening of cables to the ground rail by means of large-
surface connectors located as close as possible to the point of entry. 
Clamp cables mechanically by means of cable clamps. Route the 
connected screen to the modules without interruptions, but don't connect 
the screen again. 

• Ensure that the ground rail has a low-impedance connection to the 
cabinet/cubicle. 

• Use only metallic or metalized covers for the plugs of screened data 
lines. 

 

Basic rules for 
ensuring EMC 
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In critical cases you should implement special EMC measures 
 
• Connect suppressors to all inductive loads that are not controlled by 

special EMC-modules. 
• Use incandescent lamps for illumination purposes inside cabinets or 

cubicles, do not use of fluorescent lamps. 
 

Create a single reference potential and ensure that all electrical 
equipment is grounded wherever possible 
 
• Ensure that grounding measures are implemented effectively. The 

controllers are grounded to provide protection and for functional 
reasons. 

• Provide a star-shaped connection between the plant, cabinets/cubicles 
and the grounding/ protection system. In this way you can avoid ground 
loops. 

• Where potential differences exist you must install sufficiently large 
equipotential bonding conductors between the different parts of the 
plant. 
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EMC-equitable assembly 
 

Mostly, measures for suppressing interference voltages are only taken, 
when the control is already in commission and the perfect receive of a 
wanted signal is disturbed. 
Causes for such interference's are in the most cases inadequate reference 
potentials, coming from mistakes at the device assembly and installation. 
 

When assembling the devices, you have to ensure the large-surface 
grounding of the inactive metal parts. A correctly done grounding supports 
an unambiguous reference potential for the control and reduces the impact 
of coupled interference's. 
Grounding means the conducting connection of all inactive metal parts. The 
sum of all interconnected inactive parts is called Ground. 
Inactive parts are all conductive parts electrically separated from all active 
parts by means of a basic isolation and that may only get voltage in case of 
an error. 
The ground must not adopt dangerous contact voltage even in case of an 
error. Thus you have to connect the ground with the protected earth 
conductor. To avoid ground loops, local distant ground constructions 
(cubicles, construction and machine parts) have to be connected with the 
protected earth conductor system in star-topology. 
 
Please regard at grounding: 
• Connect the inactive metal parts as carefully as the active ones. 
• Take care of impedance-low metal-metal-connections, for e.g. with 

large-surface and well conductive contacts. 
• If you include coated or anodized metal parts in the grounding, you have 

to come through the isolating protection layers. For this you may use 
special contact washers or remove the isolation layer. 

• Protect the connection points from corrosion, e.g. with grease. 
• Moveable grounding parts (e.g. cubicle doors) have to be connected via 

flexible ground strips. The ground strips should be short and have a 
large surface, because the surface is decisive for the diversion of high 
frequency interference's. 

 
 
 
 

Guidelines for 
assembling and 
grounding of 
inactive metal 
parts 
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EMC-equitable cabling 
 

Content of this section is the line routing of bus, signal and supply lines. 
Object of the line routing is to suppress the "slurring" at parallel lines. 
 

For an EMC-equitable routing of the lines it is convenient to divide the 
cables in different groups and install each group itself: 
 

Group A 
• screened bus and data lines 
• screened analog lines 
• unshielded lines for direct voltage ≤ 60V 
• unshielded lines for alternating voltage ≤ 25V 
• Coaxial cables for monitors 
 
Group B 
• unshielded lines for direct voltage >60V and ≤400V 
• unshielded lines for alternating voltage >25V and ≤400V 
 
Group C 
• unshielded lines for direct and alternating voltage >400V 
 
Group D 
• Lines for H1 respectively TCP/IP 
 

Line routing 

Line routing inside 
and outside of 
cubicles 
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Following the table you may see the conditions for the cabling of the line 
groups by combining the single groups: 
 Group A Group B Group C Group D 
Group A [1] [2] [3] [4] 
Group B [2] [1] [3] [4] 
Group C [3] [3] [1] [4] 
Group D [4] [4] [4] [1] 
 

[1] The lines may be installed in common bundles or cable trusses. 
 

[2] The lines have to be installed in different bundles or cable trusses 
(without min. distance). 
 

[3] The lines have to be installed in different bundles or cable trusses 
inside of cubicles and outside of the cubicle but inside the building 
in separated cable trusses with a min. distance of 10cm. 
 

[4] The lines have to be installed in different bundles or cable trusses 
with a min. distance of 50cm. 
 

 

Wherever possible, exterior cabling should be installed on metallic cable 
trays. A galvanic connection must be provided for joints between cable 
trays. 
You must abide by the applicable lightning protection and grounding 
regulations when installing exterior cables. 
 
Attention! 
Where cables and signal lines for PLC equipment are installed outside of 
buildings, the conditions for internal and external lightning protection must 
be satisfied. 
 
• Exterior lines should either be installed in metallic conduit pipes that is 

grounded on both ends or in steel-reinforced concrete cable trunks with 
continuously connected reinforcing. 

• Signal lines should be protected against overvoltage by varistors or by 
lightning arrester filled with rare gas. 

• Install these protective elements at the location where the cables enter 
the building. 

 
Note! 
Any lightning protection system must be based on an individual 
assessment of the entire plant. For questions please contact VIPA GmbH.  

Combination of 
groups 

Line routing 
outside of 
buildings 

Lightning 
protection 
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Potential differences may occur between different sections when controllers 
and peripheral equipment are connected by means of non-isolated 
connections or the screens of screened cables are connected at both ends 
and grounded on different sections of the plant. 
One reason for a potential difference may be that different sections of the 
plant are powered from different power sources. These potential 
differences must be reduced by means of equipotential bonding conductors 
to ensure that the electronic equipment employed on the plant operates 
properly. 
 

• The lower the impedance of the equipotential bonding conductor, the 
higher the effectiveness of potential equalization. 

• The impedance of the equipotential bonding conductor must not exceed 
10% of the impedance of the screen where screened signal lines are 
connected between the different sections of the plant and the screening 
is connected to ground/neutral on both sides. 

• The cross-sectional area of the equipotential bonding conductor must be 
calculated to carry the maximum equalization current. The following 
cross-sections have been successfully employed:  
- 16mm2 Cu for equipotential bonding conductors up to 200m 
- 25mm2 Cu for equipotential bonding conductors exceeding 200m 

• Use copper or galvanized steel for equipotential bonding conductors. 
These must be connected to ground/neutral by means of large-surface 
connections that are protected from corrosion. 

• The equipotential bonding conductor should be installed in such a 
manner that it includes the smallest surface between the bonding 
conductor and the signal lines. 

 

Screening is one method commonly used to reduce (attenuate) the 
interference pick-up from magnetic, electrical or electromagnetic fields. 
• Interference on screens is conducted to ground by the conductive 

connection between the screen and the screening rain/enclosure. To 
avoid interference from these currents it is very important that the neutral 
connection is a low-impedance connection. 

• You should only use of cables that are provided with a braided screen. 
The degree of screening should be more than 80%. 

• Avoid cables with foil-type screens as the foil is easily damaged by 
tension and pressure at the point of attachment; this can result in 
reduced effectiveness of the screening action. 

• As a rule you should always ground the screens of cables on both ends. 
This is the only way in which you can ensure that high frequency 
interference is attenuated properly. 

 

Equipotential 
bonding 

Rules for 
equipotential 
bonding 

Screening of lines 
and cables 
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In exceptional cases it may be necessary to ground the screen on one side 
only. However, this will only attenuate the lowest frequencies. The one-
sided grounding of screens may provide advantages when: 
• It is not possible to install an equipotential bonding conductor 
• Analogue signals (a few mV or µA) must be transmitted 
• Foil-type screening (static screening) is employed. 
 
You should always use metallic or metalized covers for serial data lines. 
Connect the screen of the data line to the cover. Do not connect the screen 
to PIN 1 of the connector! 
In case of stationary operations it is recommended that the remove the 
insulation from the screened cable without cutting the screen and to attach 
this point to the screening/neutral rail. 
 

Note! 
Potential differences may give rise to an equalization current via the screen 
connected between the two ground connections. 
In this case you must install an additional equipotential bonding conductor.  
 

Please observe the following points when you handle the screens: 
• Use only metallic cable clamps when connecting the screening of 

cables. These clamps must provide a good electrical contact and a 
large-surface connection to the screen. 

• Attach the screens to the screening rail directly at the point where the 
cables enter the enclosure. The screening conductor must be continued 
to the module without interruption, however, it must not be connected to 
the module! 

 
 

 
 

 

One-sided 
grounding of 
screens 

     

Connecting the 
screen 
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Special precautions providing high noise immunity 
 

Inductors controlled by your programmable controller (e.g. contactors and 
relays) do not normally require suppressors as the respective modules 
have been provided with the required components. 
Suppressors must only be connected to inductors when output circuits can 
be disabled by means of additional contacts (e.g. relay contacts). In this 
case the integrated suppressors on the module are also disabled. 
You can connect diodes to suppress back-emc, varistors or RC-networks to 
the inductors. 
 
Connections of  
DC-activated inductors 

Connections of  
AC-activated inductors 

using a diode using a Z-diode using a varistor using RC-network 
 

-

+ +

-  
 
Every cubicle must be provided with a power outlet for the PGs. These 
outlets must be wired to the distribution system, which is also used to 
connect the neutral conductor for the cubicle. 
 
The cubicle illumination should consist of incandescent lights, e.g. 
LINESTRA-lamps. Avoid using fluorescent lamps as these lamps can 
cause interference. 
If you can not avoid using fluorescent lamps you should implement the 
steps outlined in the following figure. 
 

1

3

4

5

2

 
 

Inductors require 
suppressors 

Power outlet for 
PGs 

Cubicle 
illumination 

Suppression of 
fluorescent lamps 
in cubicles 

 
 
 
 

[1] Fluorescent lamp 
 

[2] Screen above the lamp 
 

[3] Screened cable  
 

[4] Switch with metallic cover  
 

[5] Powerline filter or screened 
power cable 
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Checklist for the EMC-compliant installation of controllers 
 

EMV-measures Space for Notes 
Connection of the inactive parts  
You should take special care to check the connections of: 
• Module racks 
• Frames 
• Screen and protected earth conductor 

 

Are all the inactive metal parts interconnected by means of 
large-surface and low-impedance connections? 

 

Has a proper connection been installed with respect to the 
ground/protected earth conductor system? 

 

Has the isolation been removed from varnished and anodized 
surfaces or have these connections been fitted with special 
contact washer? 

 

Have the connection been protected from corrosion, e.g. by 
means of grease? 

 

Have doors been grounded by means of grounding straps 
connected to the body of the cubicle? 
 

 

Cable routing  
Cabling divided into groups?  
Power cables (230...400V) and signal lines installed in 
separate channels or bunches? 
 

 

Potential compensating   
When installing the equipment at separate locations, check 
the installation of the potential compensating line. 
 

 

Cable screen  
All covers of plugs are metallic?  
All analog and data lines installed screened?  
Line screens attached to the screening or the protected earth 
conductor? 

 

Have the screens been connected by means of large-surface 
and low-impedance cable clamps? 

 

Cable screens grounded both-sided where possible? 
 

 

Inductors  
Have the coils of contactors controlled by means of contacts 
been connected to suppressors? 
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